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C H A P T E R 1

Introduction

This guide provides usage instructions for Optimal Trace Professional. To become familiar with
Optimal Trace Professional, you should first review the glossary for product-related concepts
and all of this Introduction chapter.

IMPORTANT
In addition to usage instructions for the Optimal Trace Professional edition, this guide also
contains Optimal Trace Enterprise edition usage instructions for features such as using project
templates and project baselines, managing remote projects in a database, and collaborating with
team members. These features are not supported in the Optimal Trace Professional edition.

Optimal Trace Overview
Optimal Trace is a collaborative team-oriented requirements capture and management tool. It
allows structured requirements capture, establishing a system's scope. It facilitates all aspects
of requirements capture from drafting initial notes at a customer site through generating final
requirements documents. It is designed for teams with the following roles Business Analysts,
Systems Analysts, Project Managers, Test/QA engineers, Software Architects/Designers,
providing:

• A user-friendly work environment

• An intuitive interface for capturing, viewing and managing customer requirements

• A sophisticated project collaboration tool - multiple analysts can work concurrently

• An ability to create projects from predefined or custom project templates

• An ability to generate requirements in a document format that is both comprehensible to the
customer and unambiguous to Analysts, Project Managers and Developers working on a
project

• A comprehensive report generation to HTML, commas-delimited and other formats

• A managed, concurrent working environment that is virtually transparent

7Optimal Trace Professional User Guide



• An access control for projects and project packages

• An automatic test generator for QA

• A baseline creation and management tool

• An automatic e-mail notification tool on project changes

• A comprehensive traceability tree with automatic detection of suspect links

• A powerful query and filtering mechanism

• A flexible document and text file import mechanism

At the fundamental level, the requirements-gathering paradigm is focused on two core constructs:
structured requirements and simple requirements. Structured requirements directly and
comprehensibly capture detailed functional requirements. This provides unambiguous
specifications driven by business need for all project stakeholders. A single structured requirement
is a strand of functionality proposed for a system. A collection of structured requirements can
express the entire functional behavior of a system. For example, when writing the specifications
for an online ordering system, formulate an individual structured requirement to satisfy each
goal for the set of expected users. Typical structured requirements might be Browse Orders,
Create/Edit Orders, and Login to System.
Structured requirements borrow much from the world of use cases, agile, and iterative concepts
while still allowing the capture of non-functional operational and other requirement types as
simple requirements. Optimal Trace is also designed to capture less-structured or simple
requirements. For example, it is critical to express the number of concurrent users for the
structured requirement Browse Orders, i.e. Must support 200 concurrent users. These
non-structured or non-functional requirements generally fall into two categories:

• Qualities: expressing aspects that the systemmust satisfy such as number of concurrent users,
security etc.

• Constraints: expressing hard realities such as type of infrastructure the system must run on,
coding language required, browser versions to be supported etc.

These can be captured in Optimal Trace, either by associating them with individual structured
requirements or by defining them system-wide as part of the over all project. Using refinement
relationships allows for full traceability. As important as structured requirements are for defining
functional needs, it would be a mistake to omit non-functional requirements such as scalability
or throughput. Optimal Trace, by using refinement relationships for such requirements, allows
complete traceability from functional to non-functional and vice versa. This traceability reduces
the risk of incomplete requirement specifications.

Project and Functionality Overview
Each organized set of related requirements is contained in a project. Each project can have
project level links to related resources. Additionally, each project has access to memoranda in
the form of project level notes. You can also define a glossary and a list of actors (people or
things involved) for each project. Each project contains a default requirement package, which
cannot be removed but can be renamed. It is possible to create subordinate packages. These
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packages can be named, renamed, tagged, given a unique description, copied, moved, and
removed.
The core business facing unit of Optimal Trace is the requirement. Requirements exist within
the context of a package. Two types of requirements can be created in a project, simple
requirements and structured requirements. Simple requirements are specifications you would
like the system to support. A simple requirement can optionally contain one or more items. An
item is information that supplements the simple requirement. For example, an itemmay contain
a data type name and definition. Items may contain links to related resources, and custom
properties. Simple requirements also may contain links to related resources, custom properties,
and notes. Each structured requirement can have links to related resources and its own set of
notes, custom properties, and non-functional requirements associated with it.
The core unit of a structured requirement is the step, and a requirement can be comprised of
none or many steps. Steps mimic the actions that you take to realize the goal or objective of a
requirement. The series of steps, which realize the successful completion of the main function
of the requirement, are collectively referred to as the Main Success Scenario. This could be
your structured requirement's critical path. Any series of steps within the same requirement that
provides an alternative path or solution to the main success scenario is collectively referred to
as an Alternate Scenario. This is a contingency plan for when behavior may need to address
exceptional situations. You may have any number of alternative scenarios in a requirement.
Optimal Trace Enterprise allows you to branch from one step to another step either in the same
scenario or another scenario. You can also branch from a step to an existing or new requirement,
optionally creating the requirement in the branching process.
Optimal Trace allows you to refine a step or an item to an existing or new requirement, creating
it in the process. This effectively links high to low-level requirements. This can be especially
useful when comparing as is/to be requirements that are linked to a given step at a higher level.
Optimal Trace allows you to link a requirement and all elements to an existing requirement or
other artifacts either within or across projects. Optimal Trace provides you with a document
profiles facility containing requirements document templates. Additionally, you can create your
own profiles and templates. Use document profiles to tailor generated documents to your branding
needs. Additionally, use the document profiles output to accept certain elements of the project.
Optimal Trace allows you to perform the following additional functions:

• Move a requirement or sets of requirements to another package or project andmove a package
or sets of packages to another package or project.

• Copy and paste actors, glossary items, requirements, and steps among projects.

• Search and filter within and across projects.

• Use customized and Windows shortcut keys.

• Work collaboratively on a single set of requirements, always aware of the latest changes
made by your colleagues.

• Work offline at a customer site and merge changes safely into the master requirements
document when you return to the office.

• Use local and remote projects.

• Upload your local projects to the central repository.
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• Version projects or apply baselines to projects.

• Generate test cases from business requirements.

• Spell check a project or part of a project.

• View project version history.

• Publish requirements to the web.

• Visually merge projects.

• Merge two versions of the same project.

• Merge a document into a project.

• Integrate with external test and design tools.

• Add non-Optimal Trace elements into the document.

• Reverse a document back into a project.

• Perform full round-trip engineering of Microsoft Word documents.

• Security enable projects.

• Import the contents of a text file or a Microsoft Word document into a project.

Screen Layout
When editing a project, a screen similar to the following appears. It demonstrates general project
components that exist in the product.
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Figure 1. Optimal Trace Main Screen

Optimal Trace is comprised of the following sections:

Table 1. Main Sections

DescriptionSection

Contains menus, submenus, and options that can be used when running
Optimal Trace Professional. Click the options and sub-options as required.

Menu bar

For many of the options in the submenus you will see icons, text, and
shortcut keys. For example, to create a new requirement under
Requirements in the Menu, you will see:

• Icon.

• Text - New Requirement. When the Requirements menu is extended,
click [Alt+C]. This functionality is available on other options, too.

• Shortcut key: [Ctrl+Shift+C].

Contains a list of frequently used items that can be used when running
Optimal Trace.

Tool bar

Contains a list of currently opened projects or project templates and their
respective contents. A project contained in the tree is comprised of actors,

Tree view
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DescriptionSection

glossary entries, packages collections, and structured requirements. Each
entry in the tree is referred to as a node.

Contains a miniature of the requirement map view or flow diagram view.Thumbnail view

Contains the list of queries and offers an ability to perform simple
searches. Additionally, provides the ability to create, edit, and run queries.

Query View

Contains details associated with the specific node selected in the tree
view. For example, projects or requirements.

Details view

Contains specific detail relevant to the node selected in the tree view. In
instances where requirements or packages are selected, this area displays

Right Pane View

a map of related nodes (either the requirement map or flow diagram) and
text associated with requirements.

NOTE
Click the edge of a column to adjust the width. Optimal Trace retains the width for all
requirements in the package. There are two possible scenarios for column width retention:

• Example 1: open Requirement 1 in Package 1 and adjust the column widths. Open
Requirement 2 in Package 2, and return to Requirement 1 in Package 2. Optimal Trace kept
the changed width.

• Example 2, open Requirement 1 in Package 1 and adjust the column widths. Open
Requirement 2 in Package 1, the widths set for Requirement 1 have been retained.

Optimal Trace Documentation
The Optimal Trace documentation set includes the following:

• Optimal Trace Release Notes (Enterprise, Enterprise Server, Professional)

• Optimal Trace Installation Guide

• Optimal Trace Enterprise Help

• Optimal Trace Enterprise Server Help

• Optimal Trace Professional Help

• Optimal Trace Administrator Help

• Customizing Exports and Reports Using Velocity Script

• Integration documents and Release Notes for each supported integration. Refer to SupportLine
for Optimal Trace integrations.
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Getting Help
If ever you have any problems or you would like additional technical information or advice,
there are several sources. In some countries, product support fromMicro Focus may be available
only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described below. If you
obtained it from another source, such as an authorized distributor, contact them for help first.
If they are unable to help, contact us as described below.
However you contact us, please try to include the information below, if you have it. The more
information you can give, the better Product Support can help you. But if you don't know all
the answers, or you think some are irrelevant to your problem, please give whatever information
you have.

• The name, release (version), and build number of the product.

• Installation information, including installed options, whether the product uses local or network
databases, whether it is installed in the default directories, whether it is a standalone or
network installation, and whether it is a client or server installation.

• Environment information, such as the operating system and release on which the product is
installed, memory, hardware/network specifications, and the names and releases of other
applications that were running.

• The location of the problem in the product software, and the actions taken before the problem
occurred.

• The exact product error message, if any.

• The exact application, licensing, or operating system error messages, if any.

• Your Micro Focus client, office, or site number, if available.

Contact

Our web site gives up-to-date details of contact numbers and addresses. To connect, enter
www.microfocus.com in your browser to go to the Micro Focus home page, or go to
http://supportline.microfocus.com.

Licensing
Table 2. Licensing Options

This table describes licensing options for both Optimal Trace Enterprise and Optimal Trace Professional.

DescriptionOption

Optimal Trace can be evaluated for a specific period of time without
a license key. When you first run the product, you do not require a

Evaluate Optimal Trace

license. The evaluation period is calculated from the time of first
usage, in other words from the initial running.
Once this period of time elapses youmust either purchase a full license
or else apply for an extension key.
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DescriptionOption

Aside from the initial evaluation period as outlined in the previous
section, Optimal Trace requires a license to run. It ships with a License

License the application fully or
use an extended evaluation
license key Administration utility called the LAU (License AdministrationUtility).

For full details on how to license Optimal Trace, please run the LAU
and refer to the LAU help file under the Help.

If upgrading from a previous release of Optimal Trace, you will need
to install a new license.

Upgrading from a previous
release

References
• [1] Writing Effective Use Cases, Alistair Cockburn. 2001.

• [2] Unified Modeling Language (UML), http://www.omg.org/uml/
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C H A P T E R 2

Project Menu

Project Menu Overview
Use the Project menu to create, open, close, save, save as, upload, and download your projects.
Additionally, the Project menu allows you open project templates, save projects as templates,
and apply templates. You can create project baselines and be notified of changes to specific
project elements. You can also save images of certain views of your project and you can export
your project contents to structured text-based (CSV) outputs.
The Project menu also allows you to import project data from aMicrosoft OfficeWord document
or a text file into your project. If you are logged in you can change your password from the
Project menu. Everything associated with a particular set of requirements is contained within
a project. Each project consists of collections of packages, simple requirements, structured
requirements, actors, glossaries, and a number of additional entities such as notes and links.
All projects are created initially from project templates. Using these in conjunction with custom
properties allows you to provide sets of pre-configured properties that can be used for all your
projects. Corporate standards can be encouraged and sets of useful information introduced from
project inception across the enterprise.

NOTE
Beside containing sets of custom properties, project templates can contain specific pre-built
project elements such as glossary items, packages, simple and structured Requirements, etc.
You may want to consider creating templates of common flows that tend to recur across your
projects. For example, login is a common repetitive flow.

Projects
To create remote projects, you need to configure Optimal Trace to communicate with an Optimal
Trace Enterprise Server host. A local project is stored on your computer's hard drive. Only one
user at a time can edit the local project. Local projects are stored as XML formatted text files. A
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remote project is stored in the repository (an Optimal Trace Enterprise Server) and can be viewed
and edited by multiple users concurrently.

Table 3. Project Types

Use the following table to decide which type of project you need:

DescriptionProject Type

Create a local project if:Local

• You do not wish to use any collaboration facilities within the project.

• You want to quickly get up and running on the very early stages of a project and you
are the only person modifying it.

• You are working offsite or away from your office and have no access to your
repository server.

Create a remote project if:Remote

• You want to use collaboration facilities within the project.

• You have access to your repository server.

• You want to secure the project using access control.

NOTE
It is common for users to initially create a local project and at a later point upload the project
to the server. For example, if working to capture the business information in a JAD (Joint
Application Development) workshop, initially capture the requirements directly into a local
project. Using a projector to show the graphical flows and textual detail with the business
stakeholders facilitates stakeholder agreement. When you have returned onsite or when you are
connected with the server, upload the captured information and make it your baseline.

Project Templates
When creating a new project, specify a project template. Optimal Trace ships with the following
project templates:

Table 4. Project Templates

DescriptionTemplate

This is an empty template meaning it does not have any predefined custom
properties or project structure. This is the default when running Optimal Trace
for the first time.

Empty

Use this template when defining higher level business processes. This template
contains the following custom properties:

Business Process
Template

• Project: project scope, business stakeholders
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DescriptionTemplate

• Requirement: business priority (Bound and one of high, medium, or low) and
business level (Bound and one of high, medium, or low), time, resources

• Requirement Step: time, inputs (Bound and empty), outputs (Bound and
empty) Note: Bound inputs and outputs are typically a set of predefined items.
For example, PO, invoice, etc.

Use this template as one approach when relating product/project features to
detailed requirements. This template structures a project into two packages. The

Feature Driven
Development

first package is Features with the tag FR denoting Feature Requests or Feature
Requirements. The second Detailed Requirements with tag SR denoting Software
Requirements. Capture your specific features in the features package as Simple
Requirements and the related detailed functional flows as structured requirements
in the second package. Use refinements to connect features to detailed
requirements.

Use this template to integrate with QADirector projects based on a Manual Risk
Model. This template contains custom properties that correspond to the Manual
Risk Model custom attributes.

Optimal Trace -
QADirector
Integration Manual
RiskModel Template

Use this template to integrate with QADirector projects based on a QualityPoint
Risk Model. This template contains custom properties that correspond to the
QualityPoint Risk Model custom attributes.

Optimal Trace -
QADirector
Integration
QualityPoint Risk
Model Template

Use this template to integrate withQADirector projects based on a Standard Risk
Model. This template contains custom properties that correspond to the Standard
Risk Model custom attributes.

Optimal Trace -
QADirector
Integration Standard
Model Template

Use this template when defining test requirements. Typically these requirements
will link or trace back to business requirements. This template contains the
following custom properties

QA Template

• Project: scope, out of scope, QA team, test schedule, test hardware, test
software

• Requirement: tester

• Requirement Step: expected result, result

Use this template when defining requirements for typical software projects. This
template contains the following custom properties:

Standard Software
Development

• Project: project scope, business case, project team, project schedule and
risk/mitigation

• Requirement: delivery increment (bound and one of increment 1, 2, or 3),
business priority (bound and one of High, Medium, or Low), and tech risk
(bound and one of High, Medium, or Low)
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NOTE
You may want to change the default project template when creating new projects. Click
Options>General Options to adjust the project template settings.

Creating Projects
Use this option to set up a new project. This is the first step in gathering requirements. Click
Project>New Project.

Figure 2. New Project Dialog box

Opening a Project
To open a project:

1. Click Project>Open Project.
2. Check the Open a remote project in the repository for remote projects or Open a local

project for offline (file based) projects.
3. Select the project you wish to open. To facilitate project selection, the dialog box displays

the project name, project creator, project created on date, and project last modified date.
You can sort these columns or hover over the project to view a description.

4. Click Open.
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Optimal Trace allows multiple remote projects, local projects, or a mixture of both project
types to load at any one time. If you open multiple projects, you can copy, cut, and paste
artifacts such as requirements and actors between the various projects. After creating a
Project, configure the details associated with the project, and specify properties, links,
notes, and non-functional requirements. It is also possible to customize some project settings.
Projects can be configured as security enabled meaning that permissions are applied to the
project. Security enabled projects appear in the list of projects with a key icon next to them.
If attempting to open a security enabled project, the system prompts you to login. Enter
your user name and password in the fields provided.

NOTE

• User IDs and passwords are case sensitive. Ensure that you are using the correct case
if you are having difficulty when logging in.

• When new users are created, they are assigned the default password of password. Contact
your Optimal Trace Administrator for more details. Refer to the Optimal Trace
Administrator Help for more information on users.

Working with Remote Projects
Once created, a new remote project behaves exactly like a local project. The difference is that
when you save changes, the changes are written to the repository rather that to a local disk.

About Deleting Remote Projects
You can delete remote projects in an Optimal Trace repository from the Optimal Trace Enterprise
client provided that delete permissions have been granted. For more information, see Deleting
Remote Projects [p. 19]. Additionally, you can delete remote projects from Optimal Trace
Administrator. Refer to the Optimal Trace Administrator Help for more information about
deleting remote projects and setting permissions.
Prior to deleting a project, consider doing the following:

• Taking the project offline as a precautionary measure in case you wish to recover that project
at a later time.

• Making a backup copy in the repository.

Deleting Remote Projects
To delete a remote project from the Optimal Trace client, you must have delete permission set
for the specific project to delete. Additionally, you can delete remote projects from the Optimal
Trace Administrator. For more information, refer to the Setting Project and Package Permissions
topic in the Optimal Trace Administrator Help.

1. Click Project>Delete Project.
The Delete Remote Project dialog box appears.

2. Select the project to delete, and then click Delete.
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Amessage box appears asking you to confirm the deletion. ClickYes to dismiss the message
box and delete the project.

Closing a Project
Use this option to close your local or remote project. It will no longer appear in the tree view,
but the project will remain in the repository or file folder. To close a project:

1. Click Project>Close Project. Prior to closing, if Optimal Trace detects that you do have
unsaved changes, it will prompt you to save before proceeding.

2. Click either Yes or No to close.

Saving Projects
Because the undo and redo memory is cleared after a save, you cannot undo or redo any actions
you made before saving; however, any new actions perfomed after saving a project can be
undone or redone.
To save a project:

1. Click Project>Save Project. If a project was previously saved, any changes made to the
project are automatically saved without a confirmational message appearing. For new
projects, however, the Save dialog box appears.

2. Type a name for the project in the Name field.
3. Click Save.

Saving a Project As a Different Name
Use this option to save a project as a different name. If a project is repository-based, Optimal
Trace prompts you to enter only the name of the project.

NOTE

• Use the save as option to archive repository projects. This creates a complete copy of the
project in the repository.

• The undo and redo memory is cleared after a save. Consequently, once a Project is saved
you cannot undo or redo any actions you made before saving. Any new actions since saving
can be undone or redone.

If the project is a local project (file-based project) Optimal Trace prompts you to enter the file
name of the project.
To use the Save As option for both repository and local projects:

Click Project>Save Project As.
• For repository projects, the Save Project As dialog box appears. Type a new name in the

box, and then click OK.

• For local projects, the Save dialog box appears. Type a new name, and then click Save.
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Exporting Projects
Use this option when exporting a given project to any text or structured format. Optimal Trace
ships with a number of Export Profiles. Each export profile dictates the format of the CSV
(Comma Separated Values) output file.

NOTE
When an export is created, Optimal Trace can also automatically insert a project level link to
the generated file. If you do not wish to automatically create this link, uncheck Add Report
Link to Project (locks the project).

Table 5. Default Export Profiles

DescriptionDirectoryProfile

Export to CSV (Comma-separated) Text File. Generates a report
with all the Project details in CSV format. This report is

...\projects\exportsText Export

especially good if you wish to output the content of Optimal
Trace projects into text editing tools such as notepad or Excel
spreadsheets. Since the output is delimited by commas, an Excel
worksheet can open the output for manipulation.

Generates a report with all the Project details in CSV format
(comma delimited text). UsingOptimal Trace suppliedMapping
Rules this file may then be opened in MS Project.

...\projects\exportsMS Project
Export

This report generates CSV based text files (comma delimited
text). Generates an actor oriented text output with each actor

...\projects\exportsText Actor
Usage Export

and the steps it participates in. The intent of the report is to
showwhat actors/resources interact with given steps within the
Requirements and which steps have no actor currently defined.
This is very useful for gap analysis and redundant actor
identification. An HTML version of this export is available
under the Generation>Generate Reports… menu option.

This report generates CSV based text files (comma delimited
text). Generates a text output with e.g. current details for

...\projects\exportsText As Is/To
Be Export

administrators (As-Is processes), and projected details for
system developers (To-Be processes). The Goal-levels 'As-Is'
and 'To-Be' that ship with Optimal Trace are used as
discriminators for this export. An HTML version of this export
is available under theGeneration>Generate Reports…menu
option.

This report generates an XML file, suitable for use with
Compuware Optimal J. The output generated includes: a full
listing of Requirements and each object's steps.

...\projects\exportsOptimalJ XMI
(UML)

This report generates an XML file, suitable for use with Sparx
Enterprise Architect. The output generated includes: a full
listing of Requirements and each object's steps.

...\projects\exportsEnterprise
Architect XMI
(UML)
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NOTE
Creating Custom Exports. Export Profiles rely on the velocity scripting engine and the Optimal
Trace Plug-in SDK. Velocity ships with Optimal Trace. See http://velocity.apache.org for more
details on the Velocity scripting language. See also the Customizing Exports and Reports Using
Velocity Script Reference for more on velocity in general and building exports using velocity
script.

Saving an Image File
Use this option to save an image file for what currently appears in the Requirement map and
Flow views. To save an image for a specific flow, select that flow and the saved image will
correspond to the currently displayed flow.

• Click the Requirement or Package you want to save an image of

• From the menu bar, click Project>Save Image and a save screen will appear.

The save file type will typically default to.jpg for a JPEG file. You may alternatively choose
to save in a number of other common formats including BMP, TIF etc.
Images can be saved as either the entire image or else for larger images you may want to split
the image across pages, creating different image files. To set this option, selectOptions>General
Options>Split Images across Multiple Pages/Files. You may save this image wherever you
want. Later, you can click on the image file in Windows Explorer and the image will appear on
your screen.

Exiting a Project
Use this option to exit Optimal Trace. Click Project>Exit to close the program.

NOTE
If changes have been made since opening any project(s) or if you have any unsaved changes,
the system will prompt you to save any outstanding changes prior to shutting down.

Optimal Trace Professional User Guide22

Chapter 2 ∙ Project Menu

http://velocity.apache.org


C H A P T E R 3

Optimal Trace Projects

The Optimal Trace screen is split into six different views, namely the Tree view, the Thumbnail
view, the Query view, The Traceability view, the Details view and the Right Pane view. The
Tree view contains the list of currently opened Projects and their respective contents. Each
Optimal Trace Project consists of: Actors, Glossary entries, Requirement Packages and
sub-packages, StructuredRequirements comprising scenarios and steps, and Simple Requirements
comprising items.

Project Properties
When a project is first opened, its properties are displayed in the Right Pane view. Some of
these are editable and include:

• Project Name - the name of the project

• Creator - this defaults to the login name however it can be changed

• Description - a description of the project

Non-editable properties include:

• Created On - the date and time that this project was initially created

• Location - the file location on your hard disk or on a network drive

• Baseline - the current project baseline

Project Non-Functional Requirements
Non-functional requirements can apply either at the project or discrete structured requirement
level. The latter means that the quality or constraint applies just to that structured requirement,
the former means that the non-functional requirement is project wide. Non-functional
requirements fall into two categories:

• Qualities: qualities specify criteria for which the Project or Structured Requirement must
guarantee. The Withdraw cash Requirement might have the quality that the machine is
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available 24x7 with acceptable downtime or that 95% of time receipts must be capable of
being issued.

• Constraints: examples of constraints might be that the Requirement must interact with a
specific protocol for data interchange, e.g. EDI (financials), EMI (Telco billing) or newer
standards such as ebXML etc.

Non-functional requirements must be unique by Description as qualities typically fall into
categories that can be repeated.
To access these, click on theNon-Functional Requirements tab. Just as Subjectmust uniquely
identify Notes, Non-functional requirements must be uniquely identified by description. Each
Non-functional requirement comprises:

• Category: a piece of text specifying the type of Non-functional requirement

• Non-functional requirement: a description of the actual Non-functional requirement

• Priority: a text field for you to place prioritization information.

NOTE
Non-functional Requirements can have one or more associated Custom Properties defined. To
see or modify the current set of custom properties click on the button.

Project/Requirement Links
In Optimal Trace, Links can be created at a number of levels:

• Project

• Structured Requirement

• Simple Requirement

• Simple Requirement Items

Links are used to associate two types of entities at these levels.
Any file or URL references/artifacts such as documents, graphics, URLs, Visio files, Excel
spreadsheets etc. can be associated with the project or specific requirements using a link. Trace
Links can be created to set-up Traceability relationships from one Optimal Trace project element
to another either within the current project or to an element in a different local (file) or repository
based project.
Links can be associated with Simple Requirement Items. Unlike Project/Requirement Links,
Simple Requirement Links cannot be expanded in generated documents. Each Link has a name
and description. If a linked file cannot be resolved or found at the location specified, then that
link is displayed in red.

Table 6. Link Properties

DescriptionItem

The name that you wish to call this Link, each Link name must be unique.Link Name
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DescriptionItem

This is the actual file name, URL or Optimal Trace 'Traced to' Project Element
for this Link.

Link Location

This is a visual cue indicating the type of element that is stored on the links.Icon

File and URL (web) based Links
File based Links are intended as a convenient mechanism for associating miscellaneous
information pertinent to a given requirement or the project as a whole. For example, you may
wish to store a Link to domain-specific information such as a healthcare standard document, a
government web site Link, or a sample screen shot.

• Click on the Links tab to access Links associated with the current Project or selected
Requirement.

• For Simple Requirement Items, click the button to the right of the selected item.

• To create a new Link click on the button and a new blank Link is created.

• To edit the Link location you can either edit the location field directly into the text field or
click on this Link button and a file chooser will appear. Navigate to the specific area and
select the appropriate file then click on the Open button.

The Link information is then updated in Project's Links area.

Figure 3. Project Level Links
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NOTE
User Interface Storyboards. Optimal Trace is very suitable for supporting Storyboards and
generating attendant documentation. You can associate storyboards with specific Structured
Requirements.When you generate documents, the screenshots are then embedded in the generated
document providing an excellent basis for communicating to stakeholders especially on the
Business side. Note that Links attached to Items are not expanded in the generated documentation.

Traceability Links
The second category of Links that can be created are Trace Links, these are Links to Optimal
Trace project elements. These allow any requirement or project element to be referenced as a
link associated either with the project or else with a given requirement. The process of creating
a link is similar to establishing a file-based link.

• Click on the Links tab to access Links associated with the current Project.

• Create a new Link by clicking on the button.

• The Link Location now needs to reference a given Optimal Trace element. A screen appears
allowing you to specify the given element that is being linked to.

• Select the element you want to link to and hit Apply. You can also automatically create
reverse links by checking the box.
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Figure 4. Element Trace Link

NOTE
As an alternative way of creating Trace links, you can also create Trace Links between elements
by copying URIs. In this case, the reference is created by copying the element reference via the
'Copy as Link (URI)' pop up menu. Once the reference has been copied to the clipboard, then
that reference is entered (by pasting it into the field) into the Location field of the link.

Project/Requirement Notes
Notes can be created at the project or discrete requirement level (structured and simple). The
latter means that the note is associated with the selected requirement, the former means that the
note is relevant to the entire project. Each Project or Requirement can have any number of Notes
associated with it. Click on the Notes tab to access Notes. Notes contain two fields:

• Subject: A piece of text specifying the type of Note. Each Note must have a unique Subject.

• Note: A description of the Note itself.
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Custom Properties
Projects can be created with custom properties defined for all different types of elements, e.g.
Project, Package, Structured Requirement, Simple Requirement etc. They can be customized
to hold data specific to the needs of different roles or objectives. For example, project managers
might require Requirement level custom properties of Business Priority, Increment etc., while
technical architects and QA stakeholders might want to see properties such as: Technical Risk,
Functional Tests Defined etc. associated with Simple Requirement Items. Custom Properties
can be set as either freeform or 'bound', the latter meaning you can select from one of a list of
predefined values. Custom properties can be created for all major project element types covering:

• Project

• Glossary Entries

• Actors

• Packages

• Structured Requirements

• Structured Requirement Scenario Steps

• Non-functional Requirements

• Simple Requirements

• Simple Requirement Items

In Optimal Trace, Custom Property definitions are accessible from:

• The context that the Custom Property is related to, typically via a button located in a toolbar
adjacent to the relevant element

• A centralized Settings tab at package or project level.

Custom Properties can be specific to a given package, meaning that the structure of the custom
properties is particular to requirements contained in that package. So, to outline how all of this
works, let's consider Project level custom properties. In this case, a number is defined at the
project level including Business Case, etc.
Clicking on the… brings up a Custom Properties dialog box.
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Figure 5. Project Level Custom Property Settings

You can now add, remove or modify existing Custom Properties from this screen. Defining
Custom Properties for all element types in Optimal Trace works in exactly the same way using
this screen.

• To add new custom properties click on the Add Properties button. This will insert a new
custom property. When working in a repository-based project the result of adding a custom
property is that all instances of that element in the project (Requirement etc.) acquire a lock.

• To remove an existing custom property, select the custom property by clicking on the grey
square to the left of the entry and click on the button. This will remove the custom property.
When working in a repository based project, the result of removing a custom property is that
all instances of that element in the project (Requirement etc.) acquire a lock.

To define a Custom Property as Bound, click on the checkbox to the right of the property. A
… button appears in the right-most cell of the table for this custom property. You will then be
able to add or remove given bound items by clicking the buttons.
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Figure 6. Sample Bound Values

A sample set of Custom Properties at Item Level appears in the following figure showing at
Item Level indicated by the red boundary.

Figure 7. Custom Properties showing at Item Level indicated by the red boundary
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Custom Properties and Sharing
Optimal Trace provides a very flexible mechanism for customizing projects at all levels. This
is possible using Custom Properties defined either at project wide level or specific to given
packages of requirements. You may customize the definition of the set of custom properties at
package level or a given package may share it's parent package/project's Custom Property set.
Sharing of Custom Property definitions can be done by checking the 'Share Custom Properties
with...' checkbox in the settings tab of a given package.

Figure 8. Package settings

In order to do this, you select the package, click on the 'Settings' tab. On this tab there is a 'Share
Custom Properties with' checkbox, which is checked by default (except in the case of the root
package in new projects). If you uncheck this checkbox, the package will no longer use the set
of Custom Properties defined by the parent, rather it will have its own set of independent Custom
Properties that will apply to all elements within that Package and possibly all child Packages.
For example, you may have a package entitled 'Out of Scope' which contains requirements that
are out of scope for the current release. Uncheck the Share Custom Properties with check
box. You can add a Structured Requirement level Custom Property called 'Planned for Release'
to this package by clicking on the 'Structured Requirement Custom Properties' button, and
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adding the Custom Property as before. Now only Structured Requirements created in the 'Out
of Scope' Package will have this Custom Property. If you decide at a later time that you want
the 'Out of Scope' Package to share the same Custom Properties as the rest of the Project, you
can re-check the 'Share Custom Properties' checkbox. Any Custom Properties defined in the
'Out of Scope' Package that are not defined as Custom Properties in the rest of the Project will
be removed. In the example above, re-checking the 'Share Custom Properties' check box will
mean that the 'Planned for Release' attribute is removed for all Structured Requirements in the
'Out of Scope' Package.

NOTE
To previous users of Optimal Trace. By default, when you defined a set of custom properties
in previous releases, those custom properties applied to all elements of that type created within
that project. For example, if you created a custom property called 'Technical Risk' for Structured
Requirements, every Structured Requirement in the project will have an attribute called 'Technical
Risk'. In most cases, this will satisfy the needs of your project, as typically you would tend to
capture the same information for all Requirements in your project. However there may be times
when you would like to have a different set of Custom Properties for a part of your project. For
example you may have a package entitled 'Out of Scope' which contains requirements that are
out of scope for the current release. In Optimal Trace you can for example now define a Custom
Property called 'Planned for Release' that will apply to Requirements contained in the 'Out of
Scope' package only.

Modifying Custom Properties and Locking Implications
When working online, any modifications to custom properties result in all dependent elements
acquiring a lock. Consequently, you will see a green lock icon appear next to any such elements.
For Packages, Requirements and any elements that can have Custom Properties defined, since
modifying a specific element will affect the underlying structure of all instances of that element,
you must have exclusive access to those elements prior to any modification. As an example, if
you attempt to modify the Custom Property of a 'Requirement' and another user is currently
editing any requirements in that project that use that Custom Property, then you will be unable
to perform the modification and will receive a message.

Project Settings
The settings for a Project are used to apply default values for Requirements created in the Project.
For Project Templates the settings specify values that will be applied to projects created from
those templates. To access the project settings, click on the Settings tab.
There are three sets of settings available for Projects and Project Templates:

• Goal Level

• Numbering Policy

• Custom Properties
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Goal Levels Settings
To access the Default Goal Level setting click on the button adjacent to the Default Goal Level
text. You can specify settings for the Default Goal Level; this is the goal level that will be set
whenever newRequirements are created. Goal Levels are used to specify the level of abstractness
or concreteness of a Requirement; refer to Alistair Cockburn [1].

• To edit an existing goal level for a Project, select its Name/Description and change it. If an
edited level is already in use by another Requirement, the corresponding Goal Level text
will be altered accordingly.

• To add your own new goal levels click on the Add Goal button.

• To remove a Goal Level, click on the Remove Goal button.

Figure 9. Project Specific Goal Levels screen

Table 7. Project Specific Goal Levels screen

DescriptionColumn

Click the option to set as the default Project Specific Goal Level.Default

Name of the Project Specific Goal Level.Name

Description of the Project Specific Goal Level.Description
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Numbering Policy Settings
Optimal Trace projects can have one of three types of numbering policies as outlined in the
following table. Numbering Policies affect the handling of requirement numbering in a given
project.

Table 8. Numbering Policy Settings

DescriptionNumber Policy

The Package/Tag policy means that when a new package is encountered with
a different package Tag then the numbering starts at 1. This is the default policy
in Optimal Trace Project Templates

Package/Tag Based

The Project Based policy means that all Requirements are numbered uniquely
across the project and specifically across packages.

Project Based

The Package Based policy means that Requirement numbering is reset to 1
when a new Package is encountered.

Package Based

Custom Property Settings
Projects can be created with custom properties defined at all element levels. Custom properties
can be created for projects, glossary entries, actors, packages, requirements, requirement scenario
steps, non-functional requirements, simple requirements, and simple requirement items. For
more information, see Custom Properties [p. 28].

Defining Glossary Items
It is important to define Glossary Items during a requirements gathering exercise as they provide
the common definitions as understood by domain experts.

• To define Glossary entries, under the Project click the Glossary icon. A list of Glossary
entries appears in the Right Pane view.

• You can add or remove entries by clicking the buttons in the Tool bar.

• Clicking Add allows you to add an entry.

• To remove an entry, highlight the Glossary item by clicking the button to the left of the
entry (shaded grey square) and then click on the Delete button.

Each entry consists of a name (unique within a Project) and description. It is also possible to
edit entries by clicking on the text and adjusting accordingly.

NOTE
Glossary Entries can have one or more associated Custom Properties defined. To see or modify
the current set of custom properties click on the Properties button. For more information, see
Custom Properties [p. 28].
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Defining Actors
Actors are entities that interact with a system.

• To define a newActor, under the Project click on the Actor List icon. A list of Actors appears
in the Right Pane View. Optimal Trace ships with one default Actor, the system.

• You can add or remove Actors by clicking the buttons in the Tool bar. Click on the add actor
button to add an Actor.

• To remove an Actor you must highlight the Actor by clicking the button to the left of the
entry and then click on the delete actor button. If you try to delete an Actor, which is
associated with a Step in a Requirement, then Optimal Trace will confirmwhether you really
want to delete the Actor. If you clickYes, then all of the associated Steps will be disassociated
from the deleted Actor.

Each Actor consists of a name (unique within a Project) and a description. You may edit Actors
by clicking on the text of their names and descriptions, and adjusting them accordingly.

NOTE
Actors can have one or more associated Custom Properties defined. To see or modify the current
set of custom properties click on the Properties button. For more information, see Custom
Properties [p. 28].

Packages
Packages provide a way of grouping related sets of Requirements. These can be edited by
clicking on the Package Node in the tree view and modifying them in the details area to the
bottom left of Optimal Trace. There is no restriction on the number of nested Packages that can
exist. Packages are useful when segmenting a Project into logical units. They can also be used
to specify incremental delivery units for a system. Every Project always has at least one Package,
namely the default Package labeled Requirements if created from the empty project template.
This root package housing all other Packages & Requirements cannot be deleted. Packages can
contain more packages. Requirements can be either structured, meaning they are comprised of
scenarios and steps or non-structured meaning they are either a quality or constraint type
statement.

Package Details
Each Package has the following:

• Package Name - the name of the Requirement. For example:Withdraw Cash.

• Package Tag - a tag for all requirements within the package.

• Package Description - a fuller description of the objectives of the Requirement.
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Package Tags
Package level requirements can have their own specific 'Tag'. This means that each package
can be dedicated to a specific 'Type' of structured requirement indicated by the tag. For example,
you might choose to store all your Business Process flows in one package with tag 'BP', while
a sibling package might store the corresponding detailed Software Requirements with tag 'SR'.
Alternatively Product Managers might choose to place all Product Feature Requests in one
package with tag 'FR', and detailed Requirements in a second package with tag 'DR'.

Package Custom Properties
Custom properties can be defined for Packages. This means that each Package can be set up to
hold data associated with the package. Custom Properties can be set as either freeform or 'bound',
the latter meaning you can select from one of a list of predefined values. Package Level Custom
Properties behave in exactly the same way as Project Level Custom Properties. For more
information, see Custom Properties [p. 28].

Package Settings
The Package Settings area allows you to configure whether this Package shares Custom Property
definitions with its Parent package (or Project if it's the root package), or if it has its own set of
Custom Property definitions. For more information, see Custom Properties [p. 28].

Structured Requirements
Structured requirements outline objectives or goals (and their detailed scenarios and steps)
whereas non-functional requirements cover system qualities and constraints. A structured
requirement provides a mechanism for capturing functional requirements for a system in a
comprehensible and communicable way. A single structured requirement is a strand of
functionality that a system will ultimately deliver; a collection of requirements can express the
entire functional behavior of a system. Consider, for example, writing the specifications for an
Online Ordering System. You would formulate an individual requirement to satisfy each goal
for the system needs to provide for each user (an actor). Typical goals & requirements might
be: create an order, run reports, and view shipped orders. Taken together, a set of such
requirements constitutes an entire functional specification of the order system.

NOTE
Structured Requirements are an excellent way to support Agile, Use Case driven or Business
Process projects. From an Agile perspective you can think of a structured requirement as a
formalized 'Story' of how the system will provide value to the personas or users. From a use
case perspective, a structured requirement can be considered the detail of the use case. From a
Business Process perspective a structured requirement can be thought of as a documented
business process.

Structured Requirements Properties
Each Structured Requirement has a number of properties that help clarify its purpose and nature.
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Table 9. Structured Requirements Properties

DescriptionProperty Name

Name of the Structured Requirement. For example: Order GoodsName

A fuller description of the objectives of the RequirementDescription

Something that must have happened prior to someone being able to start
this Requirement. For example, in order toWithdraw Funds, the customer
(Actor) must have an ATM card to place in the machine.

Pre-condition

Something that is true on successful completion of the Requirement. For
example when withdrawing funds the success criterion is that the funds

Post-condition

are actually withdrawn and in possession of the customer and the
customer's bank account is debited.

These are automatically built as a result of specifying Actors with Steps
in the scenario.

Actors

The importance of the Requirement - this value typically reflects two
factors, one the importance of the Requirement from a customer

Priority

perspective and two the technical or logistical risk associated with this
Requirement

Level of abstractness of the Requirement. For more information, see Goal
Levels Settings [p. 33].

Goal-level

How the Requirement is started or invoked. For example for Withdraw
Cash this might be that the customer is low on cash and wants to buy

Trigger

some goods. Triggers are useful if the Actor is a non-human and represents
another system. A batch feed signal is a good example of a more common
trigger.

Requirement will guarantee to complete some functionality and this should
be specified here.

Minimum Guarantee

Structured Requirement Custom Properties
Custom properties can be defined for Structured Requirements. This means that each Structured
Requirement can be set up to hold associated data. Custom Properties can be set as either
freeform or 'bound', the latter meaning you can select from one of a list of predefined values.
Requirement Level Custom Properties behave in exactly the same way as Project Level Custom
Properties. For more information, see Custom Properties [p. 28].

Non-Functional Requirements
NOTE
In Optimal Trace 5.0, Non-Functional Requirements are deprecated. Users wishing to capture
Non-Functional type requirements, should use Simple Requirements instead.
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Each Requirement can have an arbitrary number of Non-functional requirements associated
with it. To access these, click on the Non-functional tab. Requirement related Non-functional
requirements behave in exactly the same way as Project Non-functional requirements.

Links in Structured Requirements
Links can be associated with Requirements as well as with Projects. These provide the ability
to associate documents, graphics, URLs, etc. with the Requirement. Click on the Links tab to
access the Links associated with a Requirement. Links at the Requirement level work in exactly
the same way as Project Links. For more information, see Project/Requirement Links [p. 24].

Notes in Structured Requirements
Each Requirement can have an arbitrary number of Notes associated with it. To access these,
click on the Notes tab. Requirement Notes are useful for storing miscellaneous
issues/clarifications to do with any aspect of the Requirement. They work in exactly the same
way as Project Notes. For more information, see Project/Requirement Notes [p. 27].

Requirement Main Success Scenario and Alternate
Scenarios

A Structured Requirement consists of a set of one or more scenarios each comprising a sequence
of sub-requirements or actions (Steps). Every Structured Requirement contains a Main Success
Scenario; the objective of this is to capture the Steps that will lead to successful completion of
the Requirement. For example, the Main Success Scenario of aWithdraw Funds Requirement
is that funds are successfully withdrawn. Structured Requirements may also include alternate
paths or scenarios. Alternative scenarios may result in achieving the overall requirement or may
mean that the Requirement is not successfully completed. Some examples of unsuccessful
completion might be an ATM machine being low on cash (Alt. Scenario: Machine Low on
Cash), or an account having insufficient balance (Alt. Scenario: Machine Low on Cash). In
these cases, the objective of the Requirement could not be met. Sometimes, a Structured
Requirement can complete successfully even if an Alternate scenario applies. For example, a
machine may not have appropriate denominations to satisfy the requested amount (Alt. Scenario:
Re-specify amount), but this will not prevent possible successful completion of the Requirement
namedWithdraw Cash.

Requirements Map and Flow Diagram View
The Requirement Map View shows the relationships between this Requirement and other
Requirements, including Refinement and branch relationships. A Requirement map looks similar
to the following figure. The Flow Diagram outlines the specific flow within a structured
Requirement. This is very useful for graphically outlining the scenarios, steps and distinct
sequential business rules that trigger deviations in the flow.
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Figure 10. Requirement Map with Scenarios
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Figure 11. Requirement Flow Diagram with Scenarios

Simple Requirements
Simple Requirements allow the capture of less complex Requirements, where the Requirements
tend to have a list structure. Examples where Simple Requirements would be particularly suitable
include:

• Data oriented requirements where the need exists to specify format information in a tabular
fashion.

• Marketing and other 'flat' requirements types where a tabular structure is common.

• Feature Lists for Product Managers that can be refined to more detailed structured
requirements if necessary.

• Standard non-functional requirements types such as scalability, redundancy, etc.

Simple Requirement Properties
Each Simple Requirement has a basic set of properties that help clarify its purpose. These are:

• Name - the name of the Simple Requirement
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• Description - a fuller description of the objectives of the Requirement

Simple Requirement Custom Properties
Custom properties can be defined for Simple Requirements. This means that each Simple
Requirement can be set up to hold associated data. Custom Properties can be set as either
freeform or 'bound', the latter meaning you can select from one of a list of predefined values.
Requirement Level Custom Properties behave in exactly the same way as Project Level Custom
Properties. For more information, see Custom Properties [p. 28].

Links in Simple Requirements
Links can be associated with Simple Requirements as well as with Projects. These provide the
ability to associate documents, graphics, URLs, etc. with the Requirement. Click on the Links
tab to access the Links associated with a Requirement. Links at the Requirement level work in
exactly the same way as Project Links. For more information, see Project/Requirement Links
[p. 24].

Notes in Simple Requirements
Each Requirement can have an arbitrary number of Notes associated with it. To access these,
click on the Notes tab. Requirement Notes are useful for storing miscellaneous
issues/clarifications to do with any aspect of the Requirement. They work in exactly the same
way as Project Notes. For more information, see Project/Requirement Notes [p. 27].

Requirement Item List
A Simple Requirement contains a list of zero or more Items. Items can be used to store any kind
of information related to the Simple Requirement, for example data attributes, sets of required
product features etc.
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C H A P T E R 4

Running Searches and Querying Projects

There are two core ways in which you can Query Projects:

Simple Query
Use the Simple Query to search for text within and across Projects.

Advanced Query
• Create queries based on conditions with 'And' and 'Or' support in a Query Builder

screen. You may want to display Requirements with High Technical Risk (query on
a Requirement custom property called 'Tech Risk') or show all steps that need to be
changed (querying on a custom property called 'Needs Change?')

• Clicking any query result row auto-highlights the occurrence within the context of the
loaded project for review.

• Save Queries Locally

• Share Queries with other Team members

• View Query Results as Publishable Web Reports

To perform a query, click on the Query tab or alternatively click on the button in the tool bar.
This then brings up the query tab.

Simple Query
Use the Simple Query to search for text within and across projects. The search is performed on
the currently selected project. Enter some text, "customer", to search for and then click Run.
After a few moments, the search results appear. You can also click Clear. This results in the
current result set being cleared from the Result List. The options available when running simple
queries are outlined in the following table.
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Table 10. Simple Query Options

DescriptionOption

This restricts the search to return only those results that match the case
of the text typed into the search box.

Match Case

This restricts the search to return only those results that match based
on a complete match in the attribute, e.g. if the text that is being
searched for is a partial match this would not be considered a match.

Match Exact

Checking this option means that a full search is performed across the
entire repository.

Search Repository

Checking this option means that a full search is performed across any
projects that are currently loaded.

Search All Loaded Projects

Figure 12. Running a Simple Query for 'Order'

Table 11. Query Result Columns

DescriptionColumn

The Project in which the found artifact lives. This is useful if you are
searching across multiple projects.

Project
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DescriptionColumn

The name of the element in the project where the match occurred.Name

The name of the attribute or property whose text matched the search criterion.Attribute

The text that was matched is displayed in red text.Match

This icon denotes the type of matched element (e.g. requirement, actor, etc.).Icon

Clicking on a search result line highlights the matched Project element (Requirement etc.) in
the context where it occurs. This provides an easy way to navigate straight to the results you
are interested in. This facility is useful when reviewing a number of search results where you
might want to update the Requirements for each result. In this context once a possible change
is made, you can re-run the search and a revised set of results will appear.

NOTE
Searching the repository. It is quite possible that over a period of time, reusable elements can
be identified in several different projects housed in the Optimal Trace Server repository. Typically
there can be quite a degree of similarity between several projects in a given organization. There
might for example be very similar login requirements etc. reflected as an 'Authenticate'
requirements. You may want to quickly 'bootstrap' new project initiates by reusing some
previously defined requirements (either requirements or non-functional requirements). To
facilitate this, Optimal Trace Enterprise allows searches across the entire repository and once
project hits are encountered for a given search term, then you can load the project and copy/paste
multiple elements from the found project(s).

Advanced Query
The Advanced Query capability allows you to build upmore complex queries that filter elements
in the project. Examples of the types of queries that you might create are:

• Display all Requirements that are to be delivered in Increment 1 and 2

• Show all Legal Non-functional requirements

• Show Steps that have no actors

To enable Advanced Queries: Click on the Query tab and check the Advanced check box.
You can create, edit, delete and share queries.

Creating Queries
To create a new query clickNew. At this point theQuery Builder screen displays. Every query
is comprised of the Query Name and a collection of conditions that must be met.
To add one or more conditions for the query:

1. Click on the Element list.
2. Choose one of the elements. The list of elements is all queryable elements.
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3. Choose the attribute to be queried. The element chosen in the first step causes this list to
be populated.

4. Enter the condition to check.
5. Specify the Value. For Custom Properties that are bound, the Value list is populated with

the values specified in the definition of the custom property. For the condition options
isEmpty and isNotEmpty the Value field is disabled.

6. Click Add Condition.

Once the condition is added you may also check theMatch Case orMatch Exact options.
These behave in the same way as for simple queries.

Figure 13. Query Builder for Advanced Queries

You can also build the query such that all the conditions are met (And), or only some of the
conditions are met (Or). Leaving theMatch All Conditions box unchecked means Or while
checking it denotes And. If conditions are added that make the query irresolvable then Optimal
Trace will inform you with an appropriate message. Additionally, if you have a set of conditions
and by checking 'Match All Conditions' that query becomes irresolvable then you will be told
with a specific reason for which condition makes the query invalid.
For more information, see Advanced Query Conditions [p. 46].

Advanced Query Conditions

Table 12. Advanced Query Conditions

DescriptionCondition

The value must match the attribute in the element.Is
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DescriptionCondition

The value must not match the attribute in the element.IsNot

The attribute of the element must have no value.IsEmpty

The attribute of the element must have some value.IsNotEmpty

To remove a condition: select the Condition to be removed by clicking on it in the list of
conditions and then click Remove Condition.
From the Query Builder, you can also run the query directly. This allows you to validate that
expected results show for the query without having to dismiss the Query Screen completely.
This is a convenience allowing you to make appropriate changes in the Query Screen. You can
also Save or Delete the query by clicking the respective buttons.

Editing Queries
To edit a query:

1. In the Query tab, select the Query you want to edit from the list.
2. Click Edit.
3. Add or Remove conditions. For more information, see Creating Queries [p. 45].

Deleting Queries
To delete a query:

1. In the Query tab, select the query you want to delete from the list.
2. Click Edit.
3. Click Delete.

Viewing Query Results as an HTML Report
You can view the results of the query in a Report format by clicking the View HTML button.
This creates a single page HTML file that shows the results. The query report is created as a
file (HTML formatted) each time you click View HTML. This file is created in the following
location:
<INSTALL_DIR>\Documents and Settings\<USER_DIR>My Documents\Micro Focus\Optimal

Trace Enterprise\<REL_NUM>\EN\reports\. The file name is created as follows:
<QUERY_NAME>_Output_Report_File.html. For example: High & Medium Priority

Reqs_Output_Report_File.html.
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Figure 14. Query Results as a HTML Report

Saving Query Results in a Text File
You can save the results of the query into a CSV (Comma Separated Values) formatted Text
file. Such Text files will open in Microsoft Office Excel by default if you have this loaded on
your system. To do this: click Save Results... and specify the name of the text file.
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C H A P T E R 5

Edit and View Menus

Copy/Paste Options
You can copy and paste the following: Actors, Glossary Items, Packages, Structured
Requirements, Steps, Simple Requirements, and Items.
To copy and paste: select an item and use the Copy and Paste buttons.
If you have multiple Projects loaded, you can paste from one Project into another.
To copy multiple requirements, packages, steps or items you need to initially select multiple
elements. Optimal Trace uses the standard Microsoft Windows keys to support multiple select.
There are twomechanisms for selection. To select a range of adjacent requirements or packages,
select the beginning element in the tree and then while holding down the 'Shift' key select the
ending requirement that you wish to copy. All requirements or packages in between the initially
selected element and final element are marked for copy. Once the elements are selected then
paste into the desired new location. Alternatively to copy non-sequential single elements use
the CTRL key while selecting each desired element and paste as per normal. Requirements or
packages can be copied within the current project or into another project.
The following shortcut keys apply:

• Copy - hold down [Ctrl] and hit [C], or hold down [Ctrl] and hit [Ins] ([Insert])

• Paste - hold down [Ctrl] and hit [V], or Hold down [Shift] and hit [Ins] ([Insert])

NOTE
Copying with Custom Properties: In general when copying from one project to another, or one
package to another, if there are Custom Properties associated with the element to be copied then
the custom properties are only copied over if they are also defined in the destination. All other
standard attributes of the copied element are copied. The exception to this rule, is when the
object you are copying is a package. In this case, if there are custom properties defined on the
package then the package is pasted keeping its custom property structure. In this case the Package
Custom Property setting on the destination will have the 'Share' attribute unchecked.
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NOTE
Multiple copy of Steps and Items: Optimal Trace supports multiple copying of steps and items.
In this instance, however, the steps or items to be copied must be contiguous and individual
selection with [Ctrl] + [C] is not supported.

Copy as Link (URI)
To establish Traceability Links within or across projects you ordinarily use theAdd New Trace
Link functionality. There is, however, an alternative way to copy unique links to elements. This
is through the Copy as Link option. This creates the trace to element reference id and copies
it to the clipboard. This means that you now have a unique reference to the element. To copy
the reference to the clipboard, right-click on the specific element in the Tree.

NOTE
Starting Optimal Trace from any third-party environment is possible using copied references.
For example, if you embed the copied link reference as a link in a web page, then clicking that
reference will resolve back to the specific element in Optimal Trace. Similarly, any third-party
tool that supports invocations can make references back in the same fashion. To see an example
of this, see the generated HTML pages from the Traceability Report.

Search Option
Clicking the Search button opens the Query tab.

Undo/Redo Options
Use these options to undo/redo any actions you make, before saving. Click Edit>Undo/Redo
and Optimal Trace will undo/redo your last action.

Show/Hide Columns Option
Use this option to select specific columns to be visible while editing the project. This allows
you to focus on the specific columns that may be of interest at a given time during analysis. The
following project elements may be made visible/invisible: Non-functional Requirements, Steps,
Items, Actors, and Glossary.

Table 13. Additional Show/Hide options

DescriptionOption

Use this option to view the most recently selected Package in
your Project.

ShowCurrent Package Contents Option

Use this option to view themost recently selected Package, and
the contents of all of its sub-Packages, in your Project.

Show Current and Sub-Package
Contents Option
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DescriptionOption

Use this option to view the Requirements contained in all
Packages, in your Project, regardless of which Package you
have currently selected.

Show Contents of all Packages Option

Use this option only when you have selected either one of the
options described above.

Show Cross Package Branches and
Refinements Option

During a requirements session you may find that you are
building Requirements with large numbers of scenarios and

Expanding and Collapsing
Requirements

Steps, or a large number of Items. Optimal Trace provides a
facility for adjusting the way Requirements are displayed in
the Requirement map. When you create Requirements, they
are shown fully expanded in the Requirement Map by default.
In other words, in the case of Structured Requirements they
show all scenarios and all Steps, and in the case of Simple
Requirements they show all Items.

To collapse all structured requirements: right click on the Requirement Map and clickHide All
of the Steps in Requirements.
This will collapse the Requirements for a more manageable view. A collapsed view allows a
more convenient way of traversing the set of Requirements and highlighting specific ones for
which you can see the detailed scenarios etc. To collapse all simple requirements: Right click
on the Requirement Map and click Hide All of the Items in Requirements.

NOTE
You can also select a specific Requirement to expand by either double clicking on the
Requirement title or else clicking on its button.
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C H A P T E R 6

Requirements Menu

This allows you create, edit, delete Packages, Structured Requirements and associated Scenarios
and Steps, and Simple Requirements and associated Items. Additionally you can move and
reposition both Packages and Requirements and all associated convenience capabilities such as
Renumbering.

Creating Requirements/Packages
Choose a Package for the new requirement by selecting it in the tree view. If you have not
defined any packages, select the default Requirements Package. Click the New Structured
Requirement or New Simple Requirement button on the tool bar.
To create a new package, click the New package button on the tool bar.

Deleting Requirements/Packages
To delete a Structured or Simple Requirement, select the requirement in the tree view and click
the Delete button. If the requirement has Steps or Items you will be prompted to confirm the
deletion. If the requirement has refinements or branches associated with it, you will be prompted
to delete the requirement only or the requirement and its associated children.
To deletemultiple requirements or packages you need to initially select the requirements/packages
in the tree view. Use the standard Microsoft Windows keys to support multiple select. There
are twomechanisms for selecting. To select a range of adjacent requirements or packages, select
the beginning element in the tree and then while holding down the [Shift] key select the ending
requirements that you wish to copy. All requirements or packages in between the initially selected
element and final element are marked for deletion. Once the elements are selected then hit the
delete button. Alternatively to delete non-sequential single elements use the [Ctrl] key while
selecting each desired element and delete as per normal.

53Optimal Trace Professional User Guide



Renumbering Requirements
During the course of the requirements gathering phase, it is important to maintain the consistency
of each requirement's number. In the course of your work, new requirements are added and
existing requirements are deleted. Optimal Trace will recycle deleted requirement numbers. For
example, if you delete a requirement SR4 from a project containing the requirements SR1, SR2,
SR3, SR4 and SR5, the next requirement created will be created as SR4.
Over time youmaywant to consolidate the numbering, perhaps prior to a project being baselined.
When renumbering is applied, all of the requirements across all the packages in the project are
numbered according to the current numbering policy. If any simple requirements have been
re-numbered, their Items will also be renumbered to reflect the new Simple Requirement number.
For more information, see Project Baselines in the Optimal Trace – – Enterprise Help, and
Numbering Policy Settings [p. 34].
To apply renumbering to a project, click the Renumber button. Since renumbering is an
occasional activity and considering the implications of renumbering, you will be prompted for
confirmation of this action. Once confirmed, the renumbering is applied to all requirements.

NOTE
Renumbering of scenarios is handled automatically and no gaps are allowed to appear when
deleting scenarios.

Moving Requirements/Packages
There are two ways to move Requirements and Packages:

• Drag and drop: use standards Microsoft Windows drag and drop functionality to move your
items.

• Tool bar: select a requirement in the tree view and then click theMove Requirement button
on the tool bar and theMove Requirement to Another Package dialog box displays. Select
a location and then click Apply.

NOTE
Moving and Custom Properties. When moving from one project/package to another where
Custom Properties are associated with the element(s) to be moved, the custom property values
are only moved if the Custom Properties are defined in the destination. The one exception to
this rule is when the element being moved is a package. In this case when the package is moved,
all the custom property values are moved, and the package becomes an orphan (un-shared) if
its custom property definitions are different from that of its new parent.

NOTE
Moving and Locking. When moving requirements you acquire an explicit lock on the package
that contains the Requirement. This is because you will be changing the explicit structure of
the package on moving.
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Multiple Requirement or Package Moves

To move multiple requirements or packages at the same time you need to initially select the
requirements or packages within the tree view. Use the standardMicrosoftWindows conventions
for selecting multiple items. Once the elements are selected, follow the procedures above.

Repositioning Requirements/Packages
When you add a new requirement into a package or a package as a sub-package, that item is
positioned at the end of the current list of requirements/packages. It is possible that you may
want to re-sequence or re-order it over the lifecycle of the analysis phase or beyond.
To reposition the requirement or package: select it in the tree and click the Reposition button
in the toolbar. The Reposition dialog box displays and you can then use the Up Arrow and
Down Arrow buttons to reposition it.

Branches Menu
Use the Branchesmenu to branch from step to step and from a step to a structured requirement.
In addition to branches within a given structuredrequirement, Optimal Trace allows branching
between structured requirements. The mechanism to branch to another structured requirement
is very similar to that used for branching to steps:

• Select the step that the branch originates from, click Requirements>Branches. Branches
are denoted with a directed arrow. The arrowhead indicates the step or structured requirement
that is being branched to.

Creating a Branch
Create a branch to perform the following:

• Branch from a step to an existing step or structured requirement

• Branch from a step and implicitly create a new structured requirement while branching

In the case of Withdraw Cash for example, a branch might occur when a customer requests a
certain amount from the ATM and sufficient funds are not available. Another example is if an
incorrect multiple of currency notes has been entered (typically only multiples of 20 are handled
by many ATM machines).
To create a branch:
Click a step (either in the Flow Diagram or the Requirements Map) that you want the branch
to originate from and then click on the button in the central vertical toolbar adjacent to either
the Flow Diagram or Requirements Map. This will display the Branch Properties dialog box.
If you want to create a new structured requirement to branch to, click the New Requirement
button. This will result in the new structured requirement being created and selected as the
branch destination. A condition that causes the branch to occur can also be specified if
appropriate.
A conditional branch is depicted by a diamond box connected to the step that is branching, with
the condition displayed adjacent to the connecting line on the Flow Diagram. A conditional
branch is indicated by clicking the Conditional Branch checkbox.
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If you do not branch with a condition then no diamond is shown, instead a line is drawn directly
from the originating step to the destination step.

Editing and Deleting Branches
• Editing: Select the branch line in either the Flow Diagram or Requirements Map. Do this by

clicking on the line at which point the line is colored red. You may either edit the branch
details in the bottom left branch detail area or by clicking Requirements>Branches>Edit
Branch.

• Deleting: Select the branch line either in the Flow Diagram or Requirements Map. Click
Requirements>Branches>Delete Branch. The Delete Branch dialog box appears from
which you can delete the branch and its children or only the branch.

Steps Menu
Use this menu (Requirements>Steps) for manipulation of Steps (sub-requirements). Each
scenario is composed of a number of Steps. Each individual step is a single step of the action
required to complete a structured requirement. Together, fulfilling all of the steps in a structured
requirement results in the scenario being completed. Note the steps menu is only visible when
a structured requirement is selected in the tree.
Each step has the following attributes:

• The actor that is starting or initiating the step.

• The name of the step.

• A detailed description of the step.

• Applicable branches or refinements.

The Main Success Scenario of Withdraw Cash might contain Steps such as: insert ATM card,
prompt for PIN, enter PIN, validate PIN, or choose account type.

Step Custom Properties
Custom properties can be defined for Steps. This means that each Step can be set up to hold
associated data. Custom Properties can be set as either freeform or bound. Bound means that
you can select from one of a list of predefined values. Step Level Custom Properties behave in
exactly the same way as Project Level Custom Properties. Clicking the Custom Properties
button in the toolbar to the right of the scenario brings up the Custom Property Editor screen.

Adding and Deleting Steps
1. Click the Add Step button to add a step, or
2. Click the Delete Step button to delete a step.
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Move Step Up/Down Options
Use this option to move the selected Step up or down one position at a time in a Requirement.
Effectively you are re-ordering the steps in the given scenario. To move steps, click either the
Up or Down arrow buttons.

Items Menu
Use the Requirements>Items sub-menu for manipulation of Items. Each Simple Requirement
is composed of a number of Items. Each individual Item can describe some piece of information
that complements the Simple Requirement. Note the Items menu is only visible when a Simple
Requirement is selected in the tree view.
Each Item has the following attributes:

• The Name of the Item.

• A detailed Description of the Item.

• Applicable refinements and links.

Item Custom Properties
Custom properties can be defined for Items. This means that each Item can be set up to hold
associated data. Custom Properties can be set as either freeform or bound, the latter meaning
you can select from one of a list of predefined values. Item Level Custom Properties behave in
exactly the same way as Project Level Custom Properties. Clicking the Custom Properties
button in the toolbar to the right of the item list brings up the Custom Property editor screen.

Working with Items

Table 14. Working with Items

DescriptionAction

Use theAdd Item option to add a new Item to a Requirement. Click
the Add Item button.

Add

Use the Delete Item option to delete the selected Item from a
Requirement. Click the Delete Item button.

Delete

Use theMove Item Up/Down options to move the selected Item
up or down one position at a time in a Requirement. Effectively

Move Item Up/Down

you are re-ordering the items in the given item list. To move items,
click either the Up or Down Arrow buttons.

Use the Renumber option to renumber the Items in the item list
sequentially. Moving items up/down can cause the item numbers

Renumber

to get out of sequence. Clicking on the button will renumber the
items.
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DescriptionAction

NOTE
Over a period of time, certain items may get removed. In this case
when adding new items the new item number will be set to the
maximum possible number available, allowing holes to develop in
the numbering. This is deliberately done to preserve continuity of
number especiallywhen a broader team is receiving the requirements
and used to associating a certain item number.

Refinements Menu
Use the Requirements>Refinements menu for refinements purposes. Typically many initial
Project requirements are high level, e.g. one-line descriptions of some key functionality. We
encourage these types of requirements to be captured as 'Simple Requirements' as they provide
an invaluable audit trail especially when the Project requirements are later altered or represented
as detailed Structured Requirements associated through refinement.
The Refinement concept in Optimal Trace allows high-level requirements (perhaps Simple
Requirements with one or two Items) to be detailed to a greater degree of precision while
maintaining the original requirement with no change.When defining Refinements you can refine
across Packages. It is common that Requirements at one 'level' might exist in a dedicated package
with a given 'Tag' thereby marking these requirements as being at that level. The refined to
requirements might exist in a second dedicated package with their own Tag.
The Refinement Links a Step or Item at one level to more detailed Requirements (Simple or
Structured Requirements). Refinements are denoted by solid grey straight lines connecting the
Step or Item to the refined Requirement.

Creating Refinements
Use this option to:

• Refine from a Step or Item to an existing Requirement.

• Refine from a Step or Item and implicitly create a new requirement while refining.

In the case of the Item 'Order' in the 'Order System' demo for example, a refinement relationship
occurs between Order and Line Item, indicating that the Order contains the Line Item. Multiple
Refinement Links can be created to a given Structured or Simple requirement.
To create a refinement:

1. Click on a Step or an Item in the Requirements Map view. This will be the step/item that
'refines'.

2. Now click on the Create Refinement button in the central vertical toolbar adjacent to the
Requirements Map. This opens the Create Refinement... dialog box. This dialog box
shows each of the packages and requirements where you can refine to.

3. If you want to create a new Requirement to refine to, click New Requirement. This will
result in the new Requirement being created and selected as the refined to requirement.
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Deleting Refinements
Use this option to delete an existing Refinement. To do this, first select the refinement that you
want to delete by clicking the line from the step to the requirement in the Requirement Map.
Once selected, the refinement line changes to a red color.

Figure 15. Selecting a Refinement Line

Click theDelete button. TheDelete Refinement dialog box appears from which you can delete
the refinement and its children or only the refinement. When you click the delete refinement
button you may also delete any refined to Requirements.

Figure 16. Delete Refinement Dialog Box

Refine Requirement
Use this option to create a new refinement to another Requirement when there is no sub-step
or item already created on the 'refining' Requirement. This is a convenience option that:

• Creates a new step or item in 'refining' Requirement

• Creates the refinement relationship from that new step or item to the 'refined to' Requirement.
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Scenarios Menu
Use this menu for scenario purposes. The following options are available within the Scenarios
menu.

Table 15. Scenarios Menu Options

DescriptionOptions

Use this option to create an Alternative Scenario in a Structured Requirement.
Alternative scenarios provide an optional series of Steps to the Structured

Create New
Scenario

Requirements Main Success Scenario. This is why they are referred to as an
Alternative Scenario.

Use this option to delete an Alternative Scenario.Delete Scenario

When you add a new scenario into a Structured Requirement, that scenario is
initially positioned at the end of the current list of scenarios. From time to time,

Reposition
Scenarios…

you may want to re-sequence the alternative scenarios over the lifetime of the
analysis phase. To reposition a given scenario, first select that scenario by clicking
on the relevant scenario tab. Now click the Reposition Scenario button in the
toolbar. Use theReposition Scenario dialog box to reposition the scenario within
the requirements by using the up and down arrows.
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C H A P T E R 7

Generation Menu

Use this menu for document generation purposes.
During the requirements gathering phase of a Project, formal documentation is typically required
for customer sign off. Several versions of a requirements document may be required prior to
final sign off of a Project, and indeed an updated version may well be required after final sign
off due to subsequent changes to requirements.
Requirements documents are often the home of data that stems from multiple sources; so
managing requirements documents can be a major challenge. Ideally, changes within the
requirements document should be preserved as the document evolves. Using traditional
techniques, this type of auditing is difficult to accomplish, particularly when it must be
coordinated across a large team. Optimal Trace facilitates generation of Microsoft Office Word
documents, preserving non-Optimal Trace data within these documents. Optimal Trace also
facilitates round tripping of changes made to Optimal Trace data within these same Microsoft
Office Word documents, back into the Project.

Generate Requirements Document
Use this option to generate requirements documents in Microsoft Office Word 2000, 2003 and
2007 formats.

NOTE
Prior to generating a requirements document, you must configure theMSWord security settings.
For more information, see Configuring MS Word 2000 & 2003 Security Settings [p. 63], and
Configuring MS Word 2007 Security Settings [p. 64].

To generate a Microsoft Office Word document detailing requirements using Optimal Trace
Click on theGenerate Requirements Document button and theDocumentGeneration dialog
box will appear.
Optimal Trace has the ability to ignore custom property errors that arise during document
generation. These errors occur when custom properties in the template and the project do not
match. In previous releases, document generation stopped when it encountered inconsistencies
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in custom properties between the template and the project. In this release, users have the option
to ignore the errors in order to proceed with the documentation generation process. Users can
then view the errors and trace their location to the corresponding table. An empty token appears
in the document where the error occurred.
The Document Generation screen shows the available set of document profiles (collections
of document templates used to format the generated document), and allows you to select the
one you want to use for document generation. When you select a profile Optimal Trace
automatically suggests a file name, which is created by appending the profile name to the Project
name. You can override this default suggestion by explicitly specifying a document name
yourself. These other options are available when generating:

Table 16. Generation Options

DescriptionOption

Check this box if you have a project that has Custom Properties and wish
for them all to be added automatically. If the selected Document Profile has

Automatically Generate
Custom Properties

already been customized to have some Custom Properties included, then
this option will only add the ones that are missing.

Check this box if you wish to generate a given package from the current
project. If you check this box then a selection screen will appear when you
generate allowing you to select the specific package.

Generate Partial Project

Check this box if you wish to expand all file links in the generated document.
To define the types of files to be expanded, select Options>Tool Settings,

Expand File Links in
Document

and then type the desired file types in the Expanded File Types in
Generated Docs box.

When a document is generated Optimal Trace can also automatically insert
a project level link to the generated document. If you do not wish to

Add Document Link to
Project

automatically create this link, clear the Add Document Link to Project
(locks the project) option. The impact of adding a project link is that the
project element acquires a lock.

When a document is generated Optimal Trace inserts hidden text surrounding
the document content. This is used to identify project elements within the

Remove Hidden Text

document when the document is being updated from Optimal Trace or
reversed into Optimal Trace. Additionally, on normal generation certain
Microsoft Office Word Macros are inserted into the generated document.
These power the custommenus in documents used for reversing documents.
Using this option will remove all this hidden tag/text information from the
document. It will also not include the macros thus making the document
free of any markup. This will reduce the document size.

NOTE
RemovingHidden Text is recommended if you never intend on using reversal
of documents or if your audience is high level and you are concerned about
not being able to open the documents due to security settings. By removing
the text, reversal of documents is not possible
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Click Generate to create the document.
If you attempt to generate a document with a name that already exists, Optimal Trace informs
you of this and gives you the option of either overwriting the old document or specifying a
different name. You can cancel document generation by pressing the Cancel button on the
progress screen. When the document is created, a File Link to the document is automatically
inserted into the Project's Links area, assuming the Add Document Link To Project option
was selected.

NOTE
Forms Documents:

• Microsoft Office Word Forms: These are Microsoft Office Word documents where only
certain areas are editable. For Optimal Trace, these editable areas will generally consist of
data values originating from the Project.

• Usage: In particular, these types of documents are for nontechnical users who wish to edit
Optimal Trace documents and then reverse these changes back into the project. As long as
they keep the document protected, they can safely edit the data fields without fear of doing
any damage.

• Profiles that generate Forms documents: Default Form, Default No Images Form, Overview,
and ChangeHistory.

• Issues:

◦ Navigation is different. Press TAB or PageDown to move from formfield to formfield.

◦ Clickable hyperlinks don't work, so clicking on an external link won't do anything. Neither
will clicking on the Table of Contents, which can be annoying but is default Word
behavior. However if the document is unprotected first, via the Optimal Trace menu, then
links start working.

◦ Many of the common Microsoft Office Word facilities, such as Search, won't work until
the document is unprotected.

◦ Sometimes, when tabbing through the form fields in a documents, the focus and cursor
seem to disappear. If tab is pressed a few more times, it comes back. The reason for this
is that there are hidden form fields in some areas in the Optimal Trace document, for
instance the Branches table is completely hidden but contains form fields. If 'Toggle
Hidden Text' is selected from the Optimal Trace menu, it is clear what is going on. All
these points are as per Microsoft Word design and are beyond Optimal Trace control.

Configuring MS Word 2000 & 2003 Security Settings
Prior to generating requirement documents fromOptimal Trace, you must configure the security
settings in MS Word 2000 and 2003.

1. Open a MS Word 2000 or 2003 document.
2. Click Tools>Macro>SecurityToolsMacroSecurity.

TheMacro Security dialog box appears.
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3. Select either a Low or Medium security level.
4. On the Trusted Sources tab, select both the Trust access to Visual Basic Project and

Trust All Installed Add-Ins And Templates boxes.
5. Click OK.

Configuring MS Word 2007 Security Settings
Prior to generating requirement documents fromOptimal Trace, you must configure the security
settings in MS Word 2007.

1. Open a MS Word 2007 document.
2. Click the Office button, and then clickWord Options.

TheWord Options dialog box appears.

3. In the left pane, select Save.
4. Under Save documents, select Word Macro-Enabled Document (*.docm) from the Save

files in this format list.
5. In the left pane, select Trust Center.
6. In the right pane, select the Trust Center Settings button.

The Trust Center dialog box appears.

7. In the left pane, selectMacro Settings.
8. In the right pane, underMacro Settings, selectDisable all macros except digitally signed

macros.
9. UnderDeveloperMacro Settings, select Trust access to the VBA project object model.
10. Click OK to dismiss the dialog boxes, and then close the Word document.

Opening a Document after Generation
When you generate theMicrosoft OfficeWord document you can automatically launchMicrosoft
Office Word with the generated document open. To do this, just click the Open button when
generation is completed. This will start Microsoft Office Word and you can view or edit the
document.

Update Requirements Document Option
Use this option to update a document you previously created, for example, to reflect changes
you may have made to the Project.

NOTE

• Partial Documents cannot be updated.

• Custom Properties are Read Only in terms of Document Generation. This means that changes
to Custom Properties (add, remove or edit) will not work for updating the document. Changes
to existing Custom Property values will be updated.
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Choose the document you wish to update and click on Select. It is important that you update
the correct document. If Optimal Trace detects that the document you've selected was not
originally generated from this Project then it will inform you of this and prompt you to select
a different document.
If a problem is encountered during the document update, an error screen will appear. Optimal
Trace will attempt to locate the error in the document when you click the… button. In most
cases, the error is an easy manual fix. Note however, that fixing the error may require some
knowledge of XML. When you click…, all the hidden text in the document will be displayed.
Most of this hidden text consists of XML tags.

Editing the Requirements Document
From time to time you will want to modify a generated document outside of the Optimal Trace
environment. Optimal Trace provides full support for such edits and provides a facility for
round-tripping the changes back into a Project.

NOTE
Partial Documents cannot be reversed.

Using the Optimal Trace Menu in Microsoft Office Word
When Optimal Trace-generated documents are opened in Microsoft Office Word, a special
menu is inserted into Microsoft Office Word. Optimal Trace-generated documents exist
independently of an Optimal Trace deployment. As such, they can be edited either onsite or at
a remote location. This is useful when making changes in Microsoft Office Word documents
and then reabsorbing those changes back into an Optimal Trace project.
The following table outlines each menu option, its likely usage scenario and its
purpose/description.

Table 17. Optimal Trace Options in Microsoft Office Word

DescriptionUsageOption

This turns on and off the hidden text that Optimal Trace uses
to support round-tripping and document updates. Use this

Diagnosis & RepairToggle Hidden
Tags

option for diagnosis when a document ceases to be
round-trippable or updateable. The likelihood is that a hidden
XML tag has been inadvertently deleted.

Microsoft Office Word Forms-based documents are ones
where only specific fields are available to you for editing.

Normal EditingProtect
Document

This has the welcome side effect of protecting all the hidden
text, which otherwise could be accidentally modified. In
such Forms documents, if you want to edit in other areas of
the document, you will need to unprotect the document. This
option then re-protects the document after such an editing
session.
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DescriptionUsageOption

Microsoft Office Word Forms-based documents are ones
where only specific fields are available to you for editing.

Normal EditingUnprotect
Document

In such generated documents if you want to edit in other
areas of the document, you will need to unprotect the
document. This option allows you to do that.

This option will automatically generate a unique Optimal
Trace ID for advanced customization of documentation.

Advanced EditingInsert Unique
ID

Typically, this option is used for generating new IDs when
the user is manually adding a new Requirement.

This (rarely used) option creates a reserved area for you to
wrap certain non-Optimal Trace content which otherwise

Advanced EditingCreate Reserved
Text Area

would interfere with the normal workings of the document.
An example would be a user wishing to add some text of
their own, which contained reserved XML characters such
as < or &. Note that most normal freeform text can be freely
typed anywhere in documents without problems. Also,
binary content such pictures, Microsoft Office Excel
spreadsheets, etc. can be safely inserted in documents as-is
without needing to use this option.

This allows you create new steps, glossary items, actors,
links, notes, etc by copying an existing row in the table. Use

Normal EditingDuplicate
Current Row

this to add new entities to the document, which can then be
round-tripped back into Optimal Trace.

Disabled for generated documents.Editing a ProfileInsert Custom
Property

Disabled for generated documents.Format TablesDelete Custom
Property

Disabled for generated documents.Format TablesFormat Custom
Property Tables

Disabled for generated documents.Editing a ProfileFormat Tables

Inserting/Deleting in Microsoft Office Word

Table 18. Insert/Delete Items in Microsoft Office

DescriptionInsert/Delete Type

Inserting new steps in a scenario within Microsoft Office Word can
be done very simply. Select the row in the specific scenario that you

Steps

wish to insert steps into. Once you have the step highlighted, under
the Optimal Trace menu option click Duplicate Current Row. This
has the effect of making a copy of the currently selected step and the
name becomes 'copy of xyz step' where 'xyz step' is the selected step.
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DescriptionInsert/Delete Type

To delete steps: select the row you wish to delete and click delete as
you would with any normal table.

Inserting new items in a Simple Requirement withinMicrosoft Office
Word can be done very simply. Select the row in the specific item

Items

list that you wish to insert items into. Once you have the items
highlighted, under the Optimal Trace menu option click Duplicate
Current Row. This has the effect of making a copy of the currently
selected item and the name becomes 'copy of xyz item' where 'xyz
item' is the selected item.
To delete items: select the row you wish to delete and click delete as
you would with any normal table.

Inserting new glossary items in Microsoft Office Word can be done
very simply. First select an existing glossary item that you want to

Glossary Items

use as the basis for the new item. Once you have the step highlighted,
under the Optimal Tracemenu option clickDuplicate Current Row.
This has the effect of making a copy of the currently selected glossary
item and the name becomes 'copy of xyz item' where 'xyz item' is the
selected glossary item. Both the name and description are copied.
Note: To delete glossary items, simply select the row you wish to
delete and hit delete as you would with any normal word table.

Inserting new actors in Microsoft Office Word can be done very
simply. First select an existing actor. This will become the basis for

Actors

the new item. Once you have the actor highlighted, under the Optimal
Tracemenu option clickDuplicate Current Row. This has the effect
of making a copy of the currently selected actor and the name becomes
'copy of xyz item' where 'xyz item' is the selected actor. Both the
name and description are copied.
To delete Actors: select the row you wish to delete and click delete
as you would with any normal table.

Encoding Data
When Optimal Trace generates a document it encloses each piece of generated text within
opening and closing tags. These tags are hidden. For example:
Project Creation Date: <Project_CreationDate>Monday, Oct 22, 2003</Project_CreationDate>

Optimal Trace hides the enclosing tags, denoted by angle brackets and the title delimiters,
leaving visible text, in this case Monday, Oct 22, 2003. By clicking on the button (or the
Toggle Hidden Text item in the menu) you can toggle between the hidden and non-hidden state.
So there are two distinct portions to each generated field:

• The title of the field. This is generally freeform text and is not interpreted by Optimal Trace.
It is simply copied over as-is from the skeleton

• The value of the attribute from the Project, enclosed with: <name_of_field> value

</name_of_field>
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Modifying Existing Elements
Optimal Trace works with documents using hidden tags to wrap generated data; however, it is
possible to change the values of the data within those tags.

NOTE
When running spell check in Microsoft Office Word, do not display any hidden text. Hidden
text can be displayed/hidden by clicking the Show/Hide button.

For example, with hidden text displayed, the following text appears:
<UseCase_Precondition><!(CDATA[Clerk is logged in)]><UseCase_Precondition>

If you spell check a document with hidden text displayed, numerous errors will be found.
As long as you do not adjust the enclosing tags, changes can be made to any elements within
Microsoft Office Word and subsequently saved for merging back into the Project

NOTE
About Ids: When viewing hidden text, in generated Microsoft Office Word documents, you
will see many examples of entries similar to the following:
<Requirement_Id>27205259710765</Requirement_Id> These are special numbers used to
track individual elements. Under no circumstances should you modify these numbers, as doing
so will cause failure in subsequent updates and reversing.

Reverse Requirements Document Option
Use this option to reverse a document back into your project, e.g. after you have made changes
to elements within the document. If you have unsaved changes in your project, you will be
prompted to save these changes before reversing.

NOTE

• It is important that you are reversing a document into a project that originally generated that
document. If Optimal Trace detects that the document you've selected was not originally
generated from this project, it will inform you of this and prompt you to select a different
document.

• Custom properties are Read Only in terms of document generation. This means that changes
to custom properties (add, remove or edit) will not work for reversing the document. Changes
to existing custom property values will be reversed.

• It is not possible to reverse a document that has been generated with the Remove Hidden
Text option.

Select the document, click on Reverse. If there are problems, an error screen will appear. Click
the ... button to open the document and attempt to locate the errors.
If the document has no formatting errors, the Visual Merge screen will appear and from there
you can reconcile differences between data in the Project and the reversed document. However
if merging is not required, an explanatory screen will appear. If the Ignore DocGen Custom
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Property Errors option is selected in the General Options dialog box and an inconsistency
is found between the custom properties in the document and the custom properties in the project,
a warning message appears. Click Details to view more information regarding the warning.

Generate Reports
Use this option to publish a Project's details to the web by generating HTML pages. This allows
your customers/developers to view, at will and from anywhere, your Project requirements on
a progressive and incremental basis via your web site. This is especially useful in distributed
development scenarios, where numerous and often geographically dispersed development teams,
need to view the Project requirements. Optimal Trace ships with some ready-to-use HTML
reports, which are based on Report Profiles. There are two ways to generate a report:

• Using the Optimal Trace GUI. For more information, see Generating Reports From the
Optimal Trace Client [p. 69].

• through theMicrosoftWindowsDOSCommand Prompt. For more information, see Generate
Reports from Command Line [p. 69].

NOTE
For a list of reports to generate, refer to the document Customizing Exports and Reports Using
Velocity Script.

Generating Reports From the Optimal Trace Client
To generate a report::

1. Click Generation>Generate Reports. The Report Generation dialog box appears. The
information on this dialog box includes:
a) Profiles: Displays the name of the report profile. Profiles allow you to generate certain

elements from your Project and to adjust the branding and content.
b) Description: Displays a description of the report profile.
c) Directory: Optimal Trace automatically defaults to a directory under the reports

directory. Click the ... button to change the location in which to generate the report.

2. Select the profile to use for report generation. If you want, select a different directory to
save your generated HTML file to.

3. Click Generate.

A report is created in the specified location and a link is automatically inserted into the Project
Links area.

Generate Reports from Command Line
To generate a report of a repository project from a command line, perform the following steps:

1. Ensure that the Optimal Trace Enterprise Server is running.
2. Open a Microsoft Windows DOS Command Prompt window.
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3. Type a command that includes the Optimal Trace Command Line Report utility (Optimal
Trace Command Line Report.exe) and its required parameters.
This utility is installed by default in the following folder: <INSTALL_DIR>\Program
Files\Micro Focus\Optimal Trace\Optimal Trace Enterprise Edition\

Table 19. Command Line Report Utility Parameters

DescriptionParameter

The name of the Optimal Trace project. This must be a repository project.Project name

The name of the report profile. Available profiles are as follows:Report
profile • General Report

• Tree View Report v1.8

• Swimlane Report

• Requirement Template (AC) Report

• Actor Usage Report

• As-Is To-Be Report

• Traceability Report

• Complexity and Completeness Report

The path and folder in which the report is generated.Target folder

A user name with sufficient permissions set for the given project.User name

The password of the user.Password

The command syntax is as follows:
"Optimal Trace Command Line Report.exe" “Project name” “Profile Name” “Target folder"

“User name” “Password”

For example, to generate a a General Report in the C:\temp\reports folder for a repository
project named "Insurance", type the following command:
"Optimal Trace Command Line Report.exe" "Insurance" "General Report" "C:\temp"

"Administrator" "password"

After running the command, Optimal Trace generates a report in the specified location. A large
project may take a few minutes to generate the report.

NOTE
You could use the command prompt feature to schedule report jobs from Microsoft Windows
Scheduled Tasks. Click Start>Programs>Accessories>System Tools>Scheduled Tasks to
access this tool.
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Viewing Reports
When you generate the report, you can automatically open the default viewer for that report
type with the generated report open for viewing. To do this, just click the Open button when
generation is completed. This will launch the viewer and allow you to view the report.

NOTE
Most systems will default HTML reports to be viewed in the system's default web browser.
Similarly if you have Microsoft Office Excel installed, it is likely that the text based reports
will show in Microsoft Office Excel.
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C H A P T E R 8

Options

General Options
Click Options>General Options and then select a tab to modify application settings.

Table 20. General Options

DescriptionOptionTab

Select PDF or HTML from the list as the default Help viewing
format.

Default Help Viewing
Format

Tool Settings

Select the version ofMicrosoft OfficeWord to use for document
generation. The options areMicrosoft OfficeWord: 2007, 2003,
and 2000.

Document Generator
Word Version

Tool Settings

Specify a value for empty fields when generating Microsoft
Office Word documents. The default token is ... but this can
be changed as required.

Document Generation
Empty Token

Tool Settings

This setting is used in document generation to allow file links
to be embedded in generated documents. The default settings
for this option are:

Expanded File Types
in Generated Docs

Tool Settings

• Graphic type files: jpg, jpeg, gif, bmp, png

• Document type files: pdf, rtf

• Microsoft Office Excel spreadsheets: xls

• Text files: txt

• Microsoft Office Visio files: vsd

If modifying this list ensure you separate the extension file
types with a comma.
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DescriptionOptionTab

Select an option from the list:Default Package
Display Option

Tool Settings

• Show Current Package Contents

• Show Current and Sub-Package Contents

• Show Contents of All Packages

When tracking changes as part of Change History, Optimal
Trace loads a certain number of Change Events for viewing.

Max Num Change
History Events

Tool Settings

This setting specifies how many events are loaded at a given
time. Increasing this setting increases the load time when
viewing the Project or Element Change history as these are
loaded on demand.

Specify whether images (flow diagrams etc.) are split across
pages for document generation or when saving images to files.
Set this to specify single images or else split over pages.

Split Images across
multiple pages/files

Tool Settings

Specify that steps should be drawn as either: Fixed or Size to

Fit. When the latter option is set then the step horizontal size
Flow Diagram Step
Display

Tool Settings

is adjusted to accommodate all the text in the step name, the
former truncates the steps to be fixed to a given size.

Specify that condition text in Flow Diagrams should be either:
Fixed or Size to Fit. When the latter option is set then the

Flow Diagram Branch
Display

Tool Settings

condition horizontal size is adjusted to accommodate all the
text in the step name, the former truncates the condition text to
be fixed to a given size.

This is the default template that will appear selected when
creating new projects. You will want to set this if you are using
a given specific template for your projects.

Default Project
Template

Tool Settings

Use this option to suppress custom property errors that arise
during document generation. If selected, the document will

Ignore DocGen
Custom Property
Errors

Tool Settings

generate and display warning messages when there is an
inconsistency between the document template and the project.
Clicking Details allows you to view the custom property and
the table in which the warning occurred.
If this option is not selected, document generation will not
complete and an error message displays. This option is selected
as the default. Additionally, if this option is not selected when
reversing the requirements document into Optimal Trace, the
user will receive the Custom Property errors and the reversal
will not complete.

The default goal level for Structured Requirements. This default
can be overridden on a Project level basis by setting the Project

Default Structured
Requirement Goal
Level

Structured
Requirement
Settings default goal level. This is a drop-down menu. Select an option

from the list: Very High Summary, Summary, User Goal,
Subfunction, Too Low, As Is, To Be, Manual, or Automated.
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DescriptionOptionTab

The default Structured Requirement priority. Each new
Structured Requirement inherits this priority level. Select an
option from the list: Highest, High, Medium, Low, or Lowest.

Default Structured
Requirement Priority

Structured
Requirement
Settings

The default Non-functional requirement priority. Each
Non-functional requirement has a default priority. Select an
option from the list: P1, P2, P3, P4, or P5.

Default Non
Functional Req.
Priority

Structured
Requirement
Settings

This allows you to set whether or not spelling errors are
automatically highlighted.

Hide Spelling ErrorsSpell Check

This allows you to set whether or not the spell checker uses
suggestions from the Main Dictionary only, or also uses
suggestions from the Custom Dictionary.

Suggest from Main
Dictionary Only

Spell Check

This dictates whether or not words in UPPERCASE are ignored
during spell check.

Ignore Words with
UPPERCASE

Spell Check

Check this box if you would like the spell checker to ignore
words that contain numeric characters.

Ignore words with
numbers

Spell Check

Check this box if you would like internet and file addresses to
be ignored during spell check.

Ignore internet and file
addresses

Spell Check

This allows you to specify the location of the main dictionary
to use when checking spelling.

MainSpell Check

This allows you to specify the location of the custom dictionary
used when checking spelling. The custom dictionary contains
any words added by users.

Custom DictionarySpell Check

Spell Check and Language Support

Two dictionaries are installed with Optimal Trace: U.S. English and U.K. English. By default,
Optimal Trace is configured to use the U.S. English dictionary. Dictionaries in other languages
are supported by the Aspell spelling system and can be used with the spell check tool, however,
these have not been tested, and are not officially supported. To install a dictionary in a different
language, follow these steps:

• Download and install the Aspell installation from
http://ftp.gnu.org/gnu/aspell/w32/Aspell-0-50-3-3-Setup.exe.

• Download and install the specific language dictionary from http://aspell.net/win32.
For example for French language download and install from
http://ftp.gnu.org/gnu/aspell/w32/Aspell-fr-0.50-3-3.exe.

• Start a command prompt and type: "C:\Program Files\Aspell\bin\aspell"

--master=fr_FR dump master > fr_fr.txt, where fr_FR represents the French dictionary
(replace with desired dictionary).

• Configure the main spelling dictionary to point to the file generated in the previous step:
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◦ Copy the newly created fr_fr.txt file from “C:\Program Files\Aspell\bin” to
“C:\Documents and Settings\<USERNAME>\Application Data\Micro Focus\Optimal

Trace <Edition>\<installed version>\dictionary” and in the General Options
Dialog in Spell Check tab choose fr_fr.txt as the Main Dictionary. Optionally, use
the following method:

◦ In the General Options Dialog in Spell Check tab, choose “C:\Program
Files\Aspell\bin\fr_fr.txt” as the Main Dictionary.

Document Settings
Use the Document Settings dialog box to maintain your Project's document profiles and any
elements and templates associated with them.
A profile is a collection of templates that specifies the branding aspects of the generated document
and the exact set of data that will be output to the document. The Document Profiles pane
allows you to generate any subset of data to your documents. There is no limit to the number
of profiles you can construct and Optimal Trace ships with some ready-to-use document profiles.
Occasionally, when you are generating documents you may need to change the format of a
document that is generated. Some common situations where you might want to customize
profiles are:

• You want to place a customer's specific branding on a generated document. This might
include the customer's logo, custom header and footer.

• You want to generate only a subset of data in a given Project, for example just generate the
Actors, Glossary entries and Requirement names to the document. This is most frequently
used for overviews of the Project requirements.

The Document Profiles pane contains a list of profiles and corresponding descriptions. Click
on an item in either theName/Description columns to edit. Use theCreate,Delete, orValidate
buttons to modify existing profiles.
Adjacent to the Document Profiles pane is another pane containing the Document Elements
and Advanced (Document Templates) settings.

Document Elements

This tab contains an Incl. column and a Name column. Select the elements to include in the
selected profile by putting a check in the Incl. column next to the desired element.

NOTE
The Incl. column does not appear when the default option is selected.

Advanced (Document Templates)

This tab contains a table with the following information:

• File: Names of the template associated with the document profile selected in the Profile pane,
e.g. Style Template. You cannot edit a template's name from here.
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• Location: Displays the Microsoft Windows path to the template. To edit a path, click on its
description in the text box to select it for editing.

• Browse: This unlabelled column contains a button to navigate to a template file.

• Attach: Click the icon to edit the template.

Each profile has a set of Microsoft Office Word templates. When profiles are created the full
list of its available templates is copied into a folder, with the profile's name, which is itself
contained in the profiles directory. To omit specific areas of the profile, clear the Incl. box to
the left of the template you want to omit. The following are some of the typical reasons for
modifying a document template:

• To use a customer’s branding - within Microsoft Office Word replace the logo in Project
and adjust the header and footer in all other templates resulting in a customized set of
documents for a given customer or company.

• To limit certain data sections of data output - within the profile omit sections such as the list
of Actors, Glossary, and diagrams by unchecking the Includes box.

• To output summaries of data - within the relevant profiles omit specific data pieces wrapped
in opening and closing angle brackets.

Within each template there is a set of hidden tags. Each of these tags specifies the data that will
be generated.

• For more information, see Document Elements [p. 78].

• For more information, see Document Profile Templates [p. 77].

Document Profile Templates
The following table contains the default Document Profile Templates:

Table 21. Default Document Profile Templates

DescriptionTemplate

This generates a full requirements document with all elements of the
Project represented along with all attributes. Basically outputs all Project
data and is branded with an Optimal Trace logo.

Default

This generates a full requirements document with all elements of the
Project represented along with all attributes, usingMicrosoft OfficeWord

Default Form

forms. Outputs all Project data and is branded with an Optimal Trace
logo. To navigate through Microsoft Office Word forms, press tab or
page-down. For further information on forms, please refer to Microsoft
help.

System profile without images, using Microsoft Office Word forms.Default No Images Form

Requirement summary, using Forms.Overview

Details of the changes made to a Project's documents/files.Change History
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DescriptionTemplate

This generates a test document, with the main scenario of each
Requirement reflected as a discrete Test Case. This document is suitable

Test Specification

for projects that have been created from the QA Project Profile. It is also
used in conjunction with the Test Generation feature and is primarily used
by the QA and test stakeholders.

Document Elements
The following table describes the Document Elements and their dependencies:

Table 22. Document Element Description

DescriptionDependencyIs RequiredElement

This is used to format the Project details and
typically outputs top-level data such as the
Project's name, owner, etc.

AlwaysProject

Standard Microsoft Office Word Table of
Contents. If this element is included, the

Table Of Contents

TOC is automatically inserted on generation
of the output document.

This item is used to format the Project's
properties such as Description, or any
Custom Properties it possesses.

Introduction

This is used to format the Glossary itemsGlossary

This is used to format the Actors in the
Project

Actor List

This is used to format the Requirement Map
diagram

Requirement Map
Diagram

This is used to format the Package.Package

This is used to format the Structured
Requirement and all of its properties

Requires
Package

Dependency
exists

Requirement

This is used to format the way the Main
Success Scenario is output, specifying which
parts of the Steps are displayed

Requires
Requirement

Dependency
exists

Main Success
Scenario

This is used to format the way alternate
scenarios are output, specifying which parts
of the Steps are displayed

Requires
Requirement

Dependency
exists

Alternative Scenario

This is used to format the way
Non-functional requirements are displayed
for each Requirement

Requires
Requirement

Dependency
exists

Requirement level
Non-functionals
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DescriptionDependencyIs RequiredElement

This is used to format the way Notes are
displayed for each Requirement

Requires
Requirement

Dependency
exists

Requirement Notes

This is used to format the way Links are
displayed for each Requirement

Requires
Requirement

Dependency
exists

Requirement Links

This is used to format the flow diagram for
each Requirement

Requires
Requirement

Dependency
exists

Requirement Flow
Diagram

This is used to format the Simple
Requirement and all its properties.

Requires
Package

Dependency
exists

Simple Requirement

This is used to format the way the Item List
is output, specifying which parts of the items
are displayed

Requires Simple
Requirement

Dependency
exists

Simple Requirement
Item List

This is used to format the way Notes are
displayed for each Simple Requirement

Requires Simple
Requirement

Dependency
exists

Simple Requirement
Notes

This is used to format the way Links are
displayed for each Simple Requirement

Requires Simple
Requirement

Dependency
exists

Simple Requirement
Links

This is used to format the way
Non-functional requirements are displayed
for the Project

Project level
Non-functionals

This is used to format the way Notes are
displayed for each Project

Project Notes

This is used to format the way Links are
displayed for the Project

Project Links

This refers to the full history of the project.Change History

This is a standard Microsoft Office Word
Table Of Figures, for any images which exist
in the document.

Table of Figures

Advanced Template
Elements:

This .dot file is the Microsoft Office Word
template upon which the generated

Style Template

documents are based. It contains the
front-page logo, styles, fonts, headers and
footers, etc.

This .doc file is the Microsoft Office Word
document containing skeleton versions of

Skeleton

the Document Elements. These skeletons are
copied into the output document and
populated during the generation process.
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Changing the Document Logo
To change the document logo:

1. From the Document Settings screen select the profile desired.
2. Using the Advanced tab, edit the Style Template.
3. To change the logo, remove the Micro Focus logo and paste the desired logo in its place.

Subsequent documents generated using this profile will contain the new logo.

Changing the Header and Footer
To change the header and footer:

1. Edit the appropriate style template. Due to the fact that the default is to have a different
header and footer on the first page it is necessary to hit the enter key a number of time to
cause a second page.

2. Click View>Header and Footer and any changes made will be reflected in subsequent
generated documents.

3. Delete the carriage returns to revert to a one page style document

Outputting Custom Properties
Although Generation allows the convenience of automatically outputting Custom Properties on
document generation, it is likely that you will want to specify given Custom Properties to be
output with given Templates. To output Custom Properties:

1. Edit the Skeleton document by clicking on theMicrosoft OfficeWord icon in theAdvanced
tab of the selected Document Profile. You can add and remove Custom Properties from
the Profile and format tables.

2. In the skeleton document, position your cursor in the area associated with the element that
will have custom properties output. The following can have custom properties defined:
Project, Glossary Entries, Actors, Packages, Structured Requirements, Requirement Scenario
Steps, Simple Requirements, Simple Requirement Items, and Non-functional Requirements.
From a Microsoft Office Word perspective, these areas always correlate with tables. A
table exists for each of the Custom Property enabled elements.

3. From the Optimal Trace menu, click on Insert Custom Property. If your cursor is
incorrectly positioned you will receive a message. By default, the new Custom Property
will appear either to the right of (for a column), or below (for a row), the current cursor
point.

4. Enter the name of the Custom Property in the text entry area. The name must be exactly as
it appears in the originating Optimal Trace project. Additionally please note that the name
is case sensitive and you should ensure that the names match exactly. A screen appears
prompting you to insert the name.
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NOTE
Incorrect Custom Properties. If you specify an incorrect custom property, or are generating
from a project that does not happen to have specified custom properties, then the Generation
process will report an error. All Custom Properties in the skeleton document must have a
match in the project. For example if you specify a Custom Property called 'Risk' in the
Structured Requirements Table, each Structured Requirement in the project should have a
custom property called 'Risk'.

Deleting Custom Properties
To delete custom properties:

1. Position your cursor over the specific custom property that you want to remove. From a
Microsoft Office Word perspective, these areas always correlate with tables. A table exists
for each of the Custom Property enabled elements.

2. Select the Optimal Trace menu and click Delete Custom Property. You will be asked to
type in the name of the Custom Property you want removed. Again this data is case sensitive.
If your cursor is incorrectly positioned you will receive a message informing you of this.

Format Custom Property Tables
This option will re-format any tables in the document where it detects Custom Properties.
Typically, these tables will have varying width as columns are added and removed. Use this
option therefore to make adjustments as necessary to the left indent and to the width of these
tables.

NOTE
A bug has been reported in Microsoft Office Word where it has been observed that adding
Custom Properties can cause the table's width to become infinite. In effect the table's % size is
becoming greater than 100% of the available space. The table will appear to stretch off the page
to the right. This option provides the user with a convenient work-around for this bug.

Format Table(s)
This macro will re-format any tables selected by the user, or the table located at the cursor,
whether or not these tables contain Custom Properties. For instance to re-format any and all
tables in the document, hold down [Ctrl-A] and then use this option.
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C H A P T E R 9

Tools Menu

View All Change History Option
Use this option to audit what changes were made and by whom. This allows you to resolve
confusion or issues when dealing with any edits that may have been made to a project element.
You can view all changes made to a Project. Each change point is recorded along with the
specific detail of the actual change before and after at the level of the element, Requirement,
Actor, etc.
You can also save the change history to a CSV file. These files can then be opened in Microsoft
Office Excel so that you can perform more advanced filtering or sorting depending on your
needs. Click the Save as button to do this. The number of changes displayed can be adjusted
by setting the configurable option.

View Element History
You can also review a specific element's change history. Select the element in the Tree area and
click the View Element History button. This then brings up the specific changes made to the
selected element. Similar to the Project History, this list can be saved to a file.

Merge Two Projects
Merge can only be run for two versions of the same project. Use this option to merge Projects,
when you are:

• Merging two Projects together where you or different people have been updating different
copies of the Project. For example if going from Offline back to Online.

• Merging two Projects where two or more people might be working some distance apart from
each other, for example, offshore development scenarios where locations are not connected
by WAN and where two databases are being kept in synch.
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ClickTools>Merge Two Projects and theMerge two projects dialog box appears. Select both
Projects to merge by clicking on the File button or the Repository button, depending on where
the Project is stored. Once you have selected a Project, Optimal Trace validates that the Project
is correctly formatted and places a green tick next to the name. For more information, see
Merging Projects in the Optimal Trace – – Enterprise Help.

Spell Check
Click Tools>Spell Check to view the Spell Check dialog box. This allows you to check the
spelling in the current section of the project, or in the entire project. The spell check dialog will
highlight any incorrectly spelled words, and will suggest an alternative spelling. The following
options are available:

• Ignore Once tells the spell check tool to ignore this instance of this spelling.

• Ignore All tells the spell check tool to ignore all instances of this spelling in the project.

• Add to Dictionary adds the underlined word to the custom dictionary. Once the word has
been added to the custom dictionary, it will no longer be highlighted by the spell check tool.

• Change replaces the current instance of the word with the selected word in the Suggestions
list.

• Change All replaces all instances of the word throughout the project with the selected word
in the Suggestions list.

• Options will open the Spell Check options section of the General Options.

Once the spell check tool has finished checking the current section in the project, it will, if the
user wishes, continue checking the rest of the project.
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A P P E N D I X A

UML Integration

This section is for people who understand UML, are familiar with tracing requirements into
system design and have some experience of using design tools. It also presumes you are using
one of the available UML design tools supported by Optimal Trace. When exporting to UML,
Optimal Trace maps elements.

Table 23. UML Optimal Trace elements mapping

NotesUML EquivalentOptimal Trace
Asset

Structured Requirements are
semantically equivalent to the Use Case
notion espoused in the UML

Use CaseStructured
Requirement

Simple Requirements are semantically
equivalent to the Use Case notion
espoused in the UML

Use CaseSimple
Requirement

PackagePackage

No UML equivalentNoneGlossary Item

ActorActor

No UML equivalentStep

No UML equivalentItem

No UML equivalent for Refinement.
Closest semantic equivalent is
Requirement generalization

Represented as a Requirement
Generalization relationship:

Refinement

• Requirement with Step = UML Super
Use Case

• Refined to Requirement = UML Sub
Use Case
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NotesUML EquivalentOptimal Trace
Asset

Represented as an <<extend>> association
between the participant Requirements:

Conditional
Branch to a
Requirement • Requirement with Step => UML

Extended Use Case

• Requirement that is branched to =
UML Extending Use Case

Represented as an <<include>> association
between the participant Requirements:

Non-conditional
Branch to a
Requirement • Requirement with Step = UML Use

Case that is including

• Requirement that is branched to =
UML Included Use Case
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A P P E N D I X B

Troubleshooting

When Optimal Trace encounters problems a screen appears outlining the detail of the problem.
When a problem does occur, Optimal Trace recommends that you save any open Projects and
close the application: Click OK on the Error dialog box and then click Save in the tool bar.
Optimal Trace performs its own verification of the structure of underlying data when opening
and saving of Projects, so for the majority of problems that occur, the integrity of your data will
be guaranteed simply by saving any changes made to your Project. Simply start again, and open
the Project, and normally you can be confident that your application has recovered. An Optimal
Trace Enterprise_log is always maintained in the <INSTALL_DIR>\Documents and

Settings\<USER_DIR>\Application Data\Micro Focus\<OT_EDITION>\<RELEASE_NUM>

directory. This is a text file generated and used to collect useful information and error conditions.
In all instances where an error screen appears, you should report the circumstances and
description of the failure to Micro Focus Customer support.
You should also include, if possible, the Project.ctl file causing the problem. If the project
is a repository project take the project offline.

NOTE
If you are working with Optimal Trace Enterprise Server, ask your System Administrator to
check the Server logs and to send them also.
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A P P E N D I X C

Shortcut Keys

Table 24. Shortcut Keys

Shortcut KeyOption

[Alt+Shift+A]Insert a new Step/Item

[Alt+Shift+C]Create a new Alternative Scenario

[Alt+Shift+D]Delete a selected Refinement

[Alt+Shift+E]Refine the selected Step to an existing Requirement

[Alt+Shift+O]Delete an Alternative Scenario

[Alt+Shift+R]Refine the selected Step to a new Requirement

[Alt+Shift+S]Delete a Step

[Alt+Shift+U]Refine the selected Requirement to a new
Requirement

[Ctrl+Alt+C]Create a new Package

[Ctrl+Alt+D]Document Settings

[Ctrl+Alt+E]Renumber all Requirements

[Ctrl+Alt+I]Save an image in JPEG format

[Ctrl+Alt+K]Delete a Package

[Ctrl+Alt+O]General Options for the Tool

[Ctrl+C]Copy

[Ctrl+E]Exit
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Shortcut KeyOption

[Ctrl+F]Search within a Project

[Ctrl+K]Layout diagram

[Ctrl+M]Merge two Projects

[Ctrl+N]Create a new Project

[Ctrl+O]Open an existing Project

[Ctrl+S]Save a Project

[Ctrl+Shift+A]Apply a Label to the Project

[Ctrl+B]Branch the selected Step to new Requirement

[Ctrl+Shift+C]Create a new Requirement

[Ctrl+Shift+R]Create a new Simple Requirement

[Ctrl+Shift+D]Delete a Requirement

[Ctrl+Shift+V]View Change History

[Ctrl+V]Paste

[Ctrl+Y]Redo

[Ctrl+Z]Undo

[Alt+P+A]Save Project As

[Alt+P+T]Save Project As Template

[Alt+P+P]Apply Template to Project

[Alt+P+M]Open Project Template

[Alt+T+I]View Element History
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Glossary

Actor
An Actor is an entity that is outside the scope of a system but which interacts with the system. Actors may
be either human beings or other systems.

Alternative Scenario
This is a different flow of events within a Requirement that may lead to a successful outcome of the
Requirement. This may be invoked due to some fault or alternative provision in the Requirement.

Branch
Branching allows for a Requirement to jump from one Step within the Requirement to another, generally
due to some check passing or failing. In addition to branches within Requirements, Optimal Trace Enterprise
allows branching between Requirements.

Concrete Step
A concrete Step is a Step that does not have any refinements.

Document Profile
A profile is a collection of Templates that specifies the branding aspects of the generated document and
the exact set of data that will be output to the document. Optimal Trace ships with ready-to-use document
profiles.

External Requirement
A Requirement that is triggered by an external Actor.

Goal Level Requirements
Requirements can be classified as being of a certain goal-level thus clarifying to a large extent the audience
of the Requirement. The concept of Goal-Levels is borrowed from the work of Alistair Cockburn [1].

Internal Requirement
ARequirement that is not triggered by an Actor and is invoked by either an extends or includes relationship.

Item
An Item is essentially a name and a description. Items allow for a tabular set of information associated
with a simple requirement.

Local Project
A Project that is stored locally, normally used for a single user installation.

Main Success Scenario
This is theMain Flow of events within a Requirement leading to a successful outcome. Every Requirement
has one and only oneMain Success Scenario. TheMain Success Scenario of a Project could be considered
the critical path of a Project.

Offline Project
A Repository Project, not requiring a live connection to the Repository. An offline Project can at a later
point in time be reconciled with its Repository Project.

Package
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A group of related sets of Requirements. Used to segment a Project into logical units. The mandatory
minimum number of Packages per Project is one, namely the default Package labeled Requirements; this
Package, which houses all other Packages, cannot be deleted.

Project
A set of requirements (collections of Requirements, Actors, Glossaries, Notes, Links, functional
requirements, or Non-functional requirements).

Refinement
A refinement is a relationship between a Step and a Requirement, wherein the net-effect of the Step is
exactly equivalent to the net-effect of the Requirement.

Repository Project
A Project that is stored in the Repository requiring a live connection to it. It may be in another country.
Typically provides for multiple concurrent users with a common goal.

Round-tripping
If you have beenworkingwith copies of generated documents, away from the Project, you can re-incorporate
any changes you have made into the Project copies. This is called round-tripping.

Scenario
Any sequence of actions (Steps). Optimal Trace allows for two types of scenario: Main Success Scenario
(MSS) and Alternative Scenario (AS).

Simple Requirement
Simple Requirements are unstructured requirements and at the highest level are essentially a name and
description. Examples of Simple Requirements might be data oriented requirements where the need exists
to specific format information in a tabular fashion or marketing and other 'flat' requirements types where
a tabular structure is more suited.

Step
An action within a scenario that achieves an effect. You may branch from any Step in a Requirement to
another Step within the same Requirement, or to another Requirement, e.g. Branching (B) may be due to
some check passing or failing. You may refine from any Step in a Requirement to another Requirement,
e.g. Refining (R) links a Step at one level to a more detailed Requirement.

Structured Requirement
A Requirement is a descriptive narrative describing a specific functional objective of a system. It is
comprised of one or more Scenarios, each comprising a sequence of actions (Steps). The purpose of a
Requirement is to achieve an agreeable objective. Typically, Actors interact with Requirements.
Requirements come in two forms: internal and external. Every Requirement contains only one Main
Success Scenario (MSS). Requirements may also include multiple Alternate Scenarios (AS).

Template
Generate Project documents using preformatted templates, via the documents Profiles facility.
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Edit and View Menus 49
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69
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Glossary 91
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I
Inserting/Deleting in Microsoft Office Word 66
Introduction 7
Item Custom Properties 57
Items Menu 57

L
Licensing 13
Links 24
Links in Simple Requirements 41
Links in Structured Requirements 38

M
Merge Two Projects 83
Modifying Custom Properties and Locking Implications 32
Modifying Existing Elements 68
Move Step Up/Down Options 57
Moving Requirements/Packages 54
MS Word 2000

configuring security settings 63
MS Word 2003

configuring security settings 63
MS Word 2007

configuring security settings 64

N
Non-functional Requirements 23
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Notes in Structured Requirements 38
Numbering Policy Settings 34

O
Open a project 18
Opening a Document after Generation 64
Optimal Trace Projects 23
Options 73
Outputting Custom Properties 80

P
Package Custom Properties 36
Package Details 35
Package Settings 36
Package Tags 36
packages

overview 35
project

exiting 22
Project and Functionality Overview 8
Project Menu Overview 15
Project Properties 23
Project Settings 32
Project Templates 16
Project/Requirement Links 24
Project/Requirement Notes 27

Projects 15

Q
Queries, Creating 45
Queries, Deleting 47
Queries, Editing 47
Query Results 48
Query, Advanced 45

R
References 14
Refine Requirement 59
Refinements Menu 58
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Renumbering Requirements 54
Repositioning Requirements/Packages 55
Requirement Item List 41
Requirement Main Success Scenario and Alternate Scenarios
38
Requirements Map and Flow Diagram View 38
Requirements Menu 53
Reverse Requirements Document Option 68
Running Searches and Querying Projects 43

S
Save Image Option 22
Save Project As 20
Saving Projects 20
Saving Query Results in a Text File 48
Scenarios Menu 60
Screen Layout 10
Search Option 50
Shortcut Keys 89
Show/Hide Columns Option 50
Simple Query 43
Simple Requirement Custom Properties 41
Simple Requirement Properties 40
Simple Requirements 40
Spell Check 84
Step Custom Properties 56
Steps Menu 56
Structured Requirement Custom Properties 37
Structured Requirements 36
Structured Requirements Properties 36

T
Tools Menu 83
Traceability Links 26
Troubleshooting 87

U
UML Integration 85
Undo/Redo Options 50
Update Requirements Document Option 64
Using the Optimal Trace Menu in Microsoft Office Word 65
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View All Change History 83
View Element History 83
Viewing Query Results as an HTML Report 47
Viewing Reports 71

W
Working with Items 57
Working with Remote Projects 19
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